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Package Contents

Contents of Package:

D-Link AirPlus XTREME G VDI-624
High-Speed 2.4GHz Wireless Router

Power Adapter-DC 5V, 2.5A
Manual and Warranty on CD
2 Ethernet Cables (All the Ethernet ports are Auto-MDIX)

Note: Using a power supply with a different voltage rating than the one included with the
VDI-624 will cause damage and void the warranty for this product.

If any of the above items are missing, please contact your reseller.

System Requirements for Configuration:

Ethernet-Based High Speed Internet Connection

Computers with Windows, Macintosh, or Linux-based
operating systems with an installed Ethernet adapter

Internet Explorer Version 6.0 or Netscape Navigator
Version 6.0 and Above



Introduction

The D-Link AirPlus Xtreme G VDI-624 High-Speed Wireless Router is an 802.11g high-
performance, wireless router that supports high-speed wireless networking at home, at
work or in public places.

Unlike most routers, the VDI-624 provides data transfers at up to 108 Mbps (compared
to the standard 54 Mbps) when used with other D-Link AirPlus Xtreme G products. The
802.11g standard is backwards compatible with 802.11b products. This means that you
do not need to change your entire network to maintain connectivity. You may sacrifice
some of 802.11g’s speed when you mix 802.11b and 802.11g devices, but you will not
lose the ability to communicate when you incorporate the 802.11g standard into your
802.11b network. You may choose to slowly change your network by gradually replacing
the 802.11b devices with 802.11g devices .

In addition to offering faster data transfer speeds when used with other 802.11g products,
the VDI-624 has the newest, strongest, most advanced security features available today.
When used with other 802.11g WPA (WiFi Protected Access) and 802.1x compatible
products in a network with a RADIUS server, the security features include:

WPA: Wi-Fi Protected Access authorizes and identifies users based on a secret key
that changes automatically at a regular interval. WPA uses TKIP (Temporal
Key Integrity Protocol) to change the temporal key every 10,000 packets (a
packet is a kind of message transmitted over a network.) This insures much
greater security than the standard WEP security. (By contrast, the older WEP
encryption required the keys to be changed manually.)

802.1x: Authentication is a first line of defense against intrusion. In the Authentication
process the server verifies the identity of the client attempting to connect to the
network. Unfamiliar clients would be denied access.

For home users that will not incorporate a RADIUS server in their network, the security
for the VDI-624, used in conjunction with other 802.11g products, will still be much
stronger than ever before. Utilizing the Pre Shared Key mode of WPA, the VDI-624 will
obtain a new security key every time it connects to the 802.11g network. You only need
to input your encryption information once in the configuration menu. No longer will you
have to manually input a new WEP key frequently to ensure security, with the VDI-624,
you will automatically receive a new key every time you connect, vastly increasing the
safety of your communications.



Connections

All Ethernet Ports (WAN and LAN)
are auto MDI/MDIX, meaning you can
use either a straight-through or a
crossover Ethernet cable.

Pressing the
Reset Button
restores the
router to its
original factory
default settings.
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LEDs

mission.

WAN LED

A solid light indi-
cates connection
on the WAN port.
This LED blinks
during data trans-

WLAN LED

A solid light
indicates that the
wireless segment
is ready. This LED
blinks during
wireless data
transmission.

POWER LED

A solid light
indicates a proper
connection to the
power supply.

STATUS

A blinking light
indicates that the
VDI-624 is ready.

LOCAL
NETWORK LED

A solid light indicates
a connection to an
Ethernet-enabled
computer on ports 1-
4. This LED blinks
during data trans-
mission.




Features

Fully compatible with the 802.11g standard to provide a wireless data rate of
up to 108Mbps

Backwards compatible with the 802.11b standard to provide a wireless data
rate of up to 11Mbps

WPA (Wi Fi Protected Access) authorizes and identifies users based on a
secret key that changes automatically at a regular interval, for example:

B TKIP (Temporal Key Integrity Protocol), in conjunction with a RADIUS
server, changes the temporal key every 10,000 packets, ensuring greater
security

B Pre Shared Key mode means that the home user, without a RADIUS
server, will obtain a new security key every time the he or she connects
to the network, vastly improving the safety of communications on the
network

802.1x Authentication in conjunction with the RADIUS server verifies the
identity of would be clients

Utilizes OFDM technology (Orthogonal Frequency Division Multiplexing)

User-friendly configuration and diagnostic utilities

Operates in the 2.4GHz frequency range

Connects multiple computers to a high speed internet connection to share
the Internet connection

Advanced Firewall features

M Supports NAT with VPN pass-through, providing added security
B MAC Filtering

M P Filtering

B URL Filtering

l Domain Blocking
H Scheduling

DHCP server enables all networked computers to automatically receive IP
addresses

Web-based interface for Managing and Configuring

Access Control to manage users on the network

Supports special applications that require multiple connections

Equipped with 4 10/100 Ethernet ports, 1 WAN port, Auto MDI/MDIX



Wireless Basics

D-Link wireless products are based on industry standards to provide easy-to-use and
compatible high-speed wireless connectivity within your home, business or public access
wireless networks. D-Link wireless products will allow you access to the data you want,
when and where you want it. You will be able to enjoy the freedom that wireless networking
brings.

A WLAN is a cellular computer network that transmits and receives data with radio
signals instead of wires. WLANs are used increasingly in both home and office
environments, and public areas such as airports, coffee shops and universities. Innovative
ways to utilize WLAN technology are helping people to work and communicate more
efficiently. Increased mobility and the absence of cabling and other fixed infrastructure
have proven to be beneficial for many users.

Wireless users can use the same applications they use on a wired network. Wireless
adapter cards used on laptop and desktop systems support the same protocols as
Ethernet adapter cards.

People use wireless LAN technology for many different purposes:

Mobility - Productivity increases when people have access to data in any location
within the operating range of the WLAN. Management decisions based on real-time
information can significantly improve worker efficiency.

Low Implementation Costs — WLANs are easy to set up, manage, change and
relocate. Networks that frequently change can benefit from WLANs ease of
implementation. WLANS can operate in locations where installation of wiring may be
impractical.

Installation and Network Expansion - Installing a WLAN system can be fast
and easy and can eliminate the need to pull cable through walls and ceilings. Wireless
technology allows the network to go where wires cannot go - even outside the home or
office.

Scalability — WLANSs can be configured in a variety of topologies to meet the needs of
specific applications and installations. Configurations are easily changed and range
from peer-to-peer networks suitable for a small number of users to larger infrastructure
networks to accommodate hundreds or thousands of users, depending on the number
of wireless devices deployed.

Inexpensive Solution - Wireless network devices are as competitively priced as
conventional Ethernet network devices.



Wireless Basics (continued)

Standards-Based Technology
The VDI-624 Wireless Broadband Router utilizes the new 802.11g standard.

The IEEE 802.11g standard is an extension of the 802.11b standard. It increases the
data rate up to 54Mbps within the 2.4GHz band, utilizing OFDM technology.

This means that in most environments, within the specified range of this device, you will
be able to transfer large files quickly or even watch a movie in MPEG format over your
network without noticeable delays. This technology works by transmitting high-speed
digital data over a radio wave utilizing OFDM (Orthogonal Frequency Division Multiplexing)
technology. OFDM works by splitting the radio signal into multiple smaller sub-signals
that are then transmitted simultaneously at different frequencies to the receiver. OFDM
reduces the amount of crosstalk (interference) in signal transmissions.

The VDI-624 is backwards compatible with 802.11b devices. This means that if you have
an existing 802.11b network, the devices in that network will be compatible with 802.11g

devices at speeds of up to 11Mbps in the 2.4GHz range.



Wireless Basics (continued)

Installation Considerations

The D-Link AirPlus Xtreme G VDI-624 lets you access your network, using a wireless
connection, from virtually anywhere within its operating range. Keep in mind, however,
that the number, thickness and location of walls, ceilings, or other objects that the
wireless signals must pass through, may limit the range. Typical ranges vary depending
on the types of materials and background RF (radio frequency) noise in your home or
business. The key to maximizing wireless range is to follow these basic guidelines:

Keep the number of walls and ceilings between the VDI-624 and other network
devices to a minimum - each wall or ceiling can reduce your D-Link wireless
product’s range from 3-90 feet (1-30 meters.) Position your devices so that
the number of walls or ceilings is minimized.

Be aware of the direct line between network devices. A wall that is 1.5 feet
thick (.5 meters), at a 45-degree angle appears to be almost 3 feet (1 meter)
thick. At a 2-degree angle it looks over 42 feet (14 meters) thick! Position
devices so that the signal will travel straight through a wall or ceiling (instead
of at an angle) for better reception.

Building Materials can impede the wireless signal - a solid metal door or
aluminum studs may have a negative effect on range. Try to position wireless
devices and computers with wireless adapters so that the signal passes
through drywall or open doorways and not other materials.

Keep your product away (at least 3-6 feet or 1-2 meters) from electrical
devices or appliances that generate extreme RF noise.

10



Getting Started

Internet

/ Speed Intemet Connection
VDI-624

®
Ilw"jh-spm LAGH:z

reless Broadband Router

Computer 3 :

Desktop PC or Laploy

(Wireless Adapler Required)

Please remember that D-Link AirPlus Xtreme G wireless devices are pre-configured
to connect together, right out of the box, with their default settings.

For a typical wireless setup at home (as shown above),
please do the following:

You will need broadband Internet access (a High Speed Internet Connection into
your home or office).

S

Connect your high speed internet connection to the VDI-624 Wireless Broad-
band Router.

If you are connecting a desktop computer to your network, install the D-Link
AirPlus Xtreme G VDWL-G120 wireless USB adapter into an available USB
Connector on your desktop computer.

(See the printed Quick Installation Guide included with the network adapter.)

Install the D-Link VDWL-G650 wireless Cardbus adapter into a laptop computer.
(See the printed Quick Installation Guide included with the VDWL-G650.)

Install the D-Link DFE-530TX+ adapter into a desktop computer. The four
Ethernet LAN ports of the VDI-624 are Auto MDI/MDIX and will work with both
Straight-Through and Cross-Over cable.

(See the printed Quick Installation Guide included with the DFE-530TX+.)

11



Using the Configuration Menu

Whenever you want to configure your network or the
VDI-624, you can access the Configuration Menu by
opening the web-browser and typing in the IP Address
of the VDI-624. The VDI-624 default IP Address is

shown at right:
B Open the web browser

File Edit Wiew Favorites Tools  Help

Q- Q HMREAD

address [&] http://192.168.0.1

B Typeinthe IP Address of the Router (http://192.168.0.1)

Note: if you have changed the default IP Address assigned
to the VDI-624, make sure to enter the correct IP Address.

B Type admin in the User Name field
m Type password inthe Password field
[ ] Click OK

Note: if you have changed the default User Name and/or
Password assigned to the VDI-624, make sure to enter the
correct UserName and/or Password.

. o ][ con |
Home > Wizard
-AirPlus
i High-Speed 2.4GHz Wireless Router
The Home>Wizard i
screen will appear. © R
Please refer to the I—[
QUICk InSta‘”atIon S l mmmi.mr"ﬁl:niupw:‘r:ﬁl’l::;:n?-hu::unnngumhrﬂlﬂh
Guide for more infor- r—— P el stk g g i o
mation regarding the — By s i canligun i .
Setup Wizard.
AN
FAun Wizard I
o
Help
These buttons appear a Clicking Apply will save changes made to the page.
on most of the configu- Apply
ration screens in this
section. Please click on , Clicking Cancel will clear changes made to the page.
g g pag
the appropriate button Cancel
at the bottom of each
screen after you hE_lVG o Clicking Help will bring up helpful information regarding the page.
made a configuration Help
change.

@ Clicking Restart will restart the router. (Necessary for some changes.)

Restart

12



Using the Configuration Menu (continued)

SSID-

Channel-

WEP-

WEP Encryption-

Key Type-

Keys 1-4-

Home > Wireless

-AirPlus G-
High-Speed 2, 4GHz Wireless Router

Advanced ools Slatus Helg

Chanral: |E =
[t a2 -

WEF Enciypiian  |E4EH ‘i

Thaea ars 1he wirelese settings for the SF0&ccese PointP oion.

WAH Kay Type: [HEX v!
Kyl & O00000000
o ¢
K3 o 000000000
— - biepd - [OCOCO0000

Service Set Identifier (SSID) is the name designated for a spe-
cific wireless local area network (WLAN). The SSID’s factory
default setting is default. The SSID can be easily changed to
connect to an existing wireless network or to establish a new
wireless network.

6 is the default channel. All devices on the network must share
the same channel. (Note: The wireless adapters will automati-
cally scan and match the wireless setting.)

Wired Equivalent Privacy (WEP) is a wireless security protocol
for Wireless Local Area Networks (WLAN). WEP provides secu-
rity by encrypting the data that is sent over the WLAN. Select
Enabled or Disabled. Disabled is the default setting. (Note: If
you enable encryption on the VDI-624 make sure to also enable
encryption on all the wireless clients or wireless connection will
not be established.)

Select the level of encryption desired: 64-bit, or 128-bit.
Select HEX or ASCII.

Input up to 4 WEP keys; select the one you wish to use.

13



Using the Configuration Menu (continued)

Dynamic
IP Address-

Host Name-

MAC Address-

Clone
MAC Address-

Primary/
Secondary DNS
Address-

MTU-

Home >WAN > Dynamic IP Address

'-iﬂfriglua o
High-Speed 2.4GHz Wireless Router

I Home Advanced 00 Status Helg

¢

m_ Plamae seloriita approprisie opiion i comes ioyour BF.
F Oynamic P Addres Chicaca 1his aplion o abtain wn P eddracs sriomaicaly

framn o BP. (Far et Calika fie £ USsans)

'Tm T Sishic |P Addrese Chodsa this aplion 1o set slaic P information proddad Lo
yau by pour BF.
™ PFPIE Chiced s 1his aption ¥ yow IEP ke PPPIE (Far madsk
DEL usams)
WN | ™ Cthers PPIF and BigFond Cable
© PRTR lar Eunpe usa onlf]
Husat bame DiEz4 {apticea)
——
DHCP FAC Addnacd E -F-rF .,_FF -F-
E {aptional] Clare WAL Address
@ 00

Appdy Cancol Help

Choose Dynamic IP Address to obtain IP Address information
automatically from your ISP. Select this option if your ISP does
not give you any IP numbers to use.

The Host Name is optional but may be required by some ISPs.
The default host name is the device name of the Router and may
be changed.

The default MAC Address is set to the WAN's physical inter-
face MAC address on the Broadband Router. It is not recom-
mended that you change the default MAC address unless re-
quired by your ISP.

The default MAC address is set to the WAN's physical interface
MAC address on the Broadband Router. You can use the “Clone
MAC Address” button to copy the MAC address of the Ethernet
Card installed by your ISP and replace the WAN MAC address
with the MAC address of the router. It is not recommended that
you change the default MAC address unless required by your
ISP.

Enter a DNS Address if you do not wish to use the one
provided by your ISP.

Enter an MTU value only if required by your ISP. Otherwise, leave
it at the default setting. 14



Using the Configuration Menu (continued)

Static IP Address-

IP Address-

Subnet Mask-

ISP
Gateway Address-

Primary
DNS Address-

Secondary
DNS Address-

MTU-

Home > WAN > Static IP Address

-AirPlus
"
High-5peed 2.4GHz Wireless Router

|
Home Advanced ools Status Help

Plamae aeleci 1hs sppropnsts opion b comnest 1o pour ISP,

Wizdrd

- ) Dymamic P Addacs Chooss 1his option 10 obtan = P addes siomaticaly
fom pour ISP Far moet Cable madem ussm)
— = Siadic 1P B was Choaes 1his option 1o eet sistic [P information provided b
Worplpss yau by pour 5P
~f PPPLE Cheoss 1hie option ¥ your ISP iaes PPPOE (For moet
CSL umars)
E O Others PPTP and BigPard Cable
“ PR flar Europe uzs onky)
— ail
LAN

IF Addrese | tasmigred by your BF)

— Subrel kaek 001
|1EP Gabrsay Sddrese a0aa
Primry DS Adress 10101
Secondary ONS Addraes 000 foptional]

9 900
Apply Concel Help

Choose Static IP Address if all WAN IP information is provided to
you by your ISP. You will need to enter in the IP address, subnet
mask, gateway address, and DNS address(es) provided to you
by your ISP. Each IP address entered in the fields must be in the
appropriate IP form, which are four octets separated by a dot
(x.x.x.x). The Router will not accept the IP address if it is not in
this format.

Input the public IP Address provided by your ISP.

Input your Subnet mask. (All devices in the network must have
the same subnet mask.)

Input the public IP address of the ISP to which you are
connecting.

Input the primary DNS (Domain Name Server) IP address
provided by your ISP.

This is optional.

Enter an MTU value only if required by your ISP. Otherwise, leave
it at the default setting. 15



Using the Configuration Menu (continued)

Please be sure to
remove any
existing
PPPOE client
software
installed on your
computers.

Choose PPPOE (Point
to Point Protocol over
Ethernet) if your ISP
uses a PPPoE con-
nection. Your ISP will
provide you with a
username and pass-
word. Select Dynamic
PPPOE to obtain an IP
address automatically
for your PPPOE con-
nection. Select Static
PPPOE to use a static
IP address for your
PPPOE connection.

PPPOE-

User Name-

Retype Password-

Service Name-
IP Address-

Primary DNS
Address-

Secondary DNS
Address-

Home > WAN > PPPoE

D-Link

Raicting Mertwarks Frr Progis

Plesiea salact thie appropiiae option 1o conract b yauwr 1EP.

‘Wizord

i |
-
[ ]

Chatse this opikan o obrisin an 1P address auamalcelly
fiom your IEP, [Foe misi Cable modem e

Chapse this optian b s=1 etatic P nfarmation prosded 1o
you by your 150

Chapse this ogtion f pour 3P uese PPPOE. [For mest
DL wmer)

PPTF and BigPond Cable

{for Evrape uae anly)

3 Drpreamac P Addreae

) Etalic P Addrags
Wiroloss

) PPPaE
- Oitars

& PRTR
e

& Oynamic FPPaE } Sialic PPPLE
Uiser Name

Pazsward

Retype P eword
Serica Mame

P Addees

Primary DKS Addrass
Carordery DHE Address
Wharimum Ide Tme ]
WTU 4
Auir-recomes & Enabled O Disabled

|opimmal

[opisaral
Wiruries

® 900

Apply Comcel Help

Choose this option if your Service Provider uses PPPOE.

Dynamic PPPoE-receive an IP Address automatically from your ISP.
Static PPPoE-you have an assigned (static) IP Address.

Your PPPoOE username provided by your Service Provider.

Re-enter the PPPoE password

Enter the Service Name provided by your Service Provider
(optional).

This option is only available for Static PPPoOE. Enter the static IP
Address for the PPPoE connection.

Primary DNS IP address provided by our ISP

This option is only available for Static PPPoE. Enter the static IP
Address for the PPPoE connection.

(Continued on the next page)
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Using the Configuration Menu (continued)

Home > WAN > PPPoE continued

MTU- Maximum Transmission Unit-1492 is the default setting-you may
need to change the MTU for optimal performance with your
specific ISP.

Auto-reconnect- If enabled, the VDI-624 will automatically connect to your ISP
after your system is restarted or if the PPPOE connection is
dropped.

Home > LAN
-AirrPlus
(o
High-Speed 2.4GHz Wireless Router

Home Advanced aols Status Helg

Tha P sddrees of {he DHE4.

IP Addres 190 163.0.1
Subrel Wask 5 e a0

Locsl Damain Mams 1 {aptionsl]

Wireless

WAN

L) O
i@
=
L+

DHCR

LAN is short for Local Area Network. This is considered your internal network. These are
the IP settings of the LAN interface for the VDI-624. These settings may be referred to as
Private settings. You may change the LAN IP address if needed. The LAN IP address is
private to your internal network and cannot be seen on the Internet.

IP Address- The IP address of the LAN interface. The default IP address is:
192.168.0.1

Subnet Mask- The subnet mask of the LAN interface.
The default subnet mask is 255.255.255.0

Local Domain- This field is optional. Enter in the local domain name.

17



Using the Configuration Menu (continued)

Home > DHCP

Dlink g T—
High-5peed 2. 4GHz Wireless Router

Home Advanced B0 Status Helg

The DHE2 con b serivp s & DHCP Sever to distnbuie IP addressse to 1he L&H

1]

network
DOHCP Senver & Enghkad T Omshkad
Starting P Addres 82 168 .0 100
Wireless
Erding IP Address 102, 168 . 0. [189
Lsasa Tirmsa 1 Wagk =
WAH a Lr
3
Apply Cancel Help
LAN
Hasi Name - P Addnass WAL Eddieas Epiizad Tire

mhoosen 1921680101 00-50-BA-TD-ES-B1  Jaaf3r2003 170605

i

DHCP stands for Dynamic Host Control Protocol. The VDI-624 has a built-in DHCP
server. The DHCP Server will automatically assign an IP address to the computers on
the LAN/private network. Be sure to set your computers to be DHCP clients by setting
their TCP/IP settings to “Obtain an IP Address Automatically.” When you turn your
computers on, they will automatically load the proper TCP/IP settings provided by the
VDI-624. The DHCP Server will automatically allocate an unused IP address from the IP
address pool to the requesting computer. You must specify the starting and ending

address of the IP address pool.

DHCP Server- Select Enabled or Disabled. The default setting is Enabled.
Starting

IP Address- The starting IP address for the DHCP server’s IP assignment
Ending

IP Address- The ending IP address for the DHCP server’s IP assignment
Lease Time- The length of time for the IP lease. Enter the Lease time. The

default setting is one hour

18



Using the Configuration Menu (continued)

Advanced > Virtual Server

High-Speed 2. 4GHz Wireless Router

e
“wiriual Server e usad (o alkn Inbameal waers eocats o LAN wamoas
Hanm | Claw
WIEIP ,7
Pratoed Tipa | TCP ';
RIRES
i Publiz Parl
e s
™ Fram fime [00 =] - [00 =] [Ar 2] 1o [00 =] - [00 =] [am =]
T day | Bun 'Fi fo | Bun ‘]
-
ful Li Apply Concel Help
Harm Friaie IF - Proincol Schedule
I Wirual Sener FTP 0na0 TR a6
I Wirll Server HTTP 0000 TR ANEN weays  [dH
I Wirual Senver HTTFS anan TCF 43043 LT HE
I Vidual Senver OKS ooan UOF 6353 Bhways R

The VDI-624 can be configured as a virtual server so that remote users accessing'
Web or FTP services via the public IP address can be automatically redirected to
local servers in the LAN (Local Area Network).

The VDI-624 firewall feature filters out unrecognized packets to protect your LAN
network so all computers networked with the VDI-624 are invisible to the outside
world. If you wish, you can make some of the LAN computers accessible from the
Internet by enabling Virtual Server. Depending on the requested service, the VDI-624
redirects the external service request to the appropriate server within the LAN
network.

The VDI-624 is also capable of port-redirection, meaning incoming traffic to a
particular port may be redirected to a different port on the server computer.

Each virtual service that is created will be listed at the bottom of the screen in the
Virtual Servers List. There are pre-defined virtual services already in the table. You
may use them by enabling them and assigning the server IP to use that particular
virtual service.

19



Using the Configuration Menu (continued)

Advanced > Virtual Server continued

Virtual Server-
Name-

Private IP-

Protocol Type-

Private Port-

Public Port-

Schedule-

Example #1:

Select Enabled or Disabled.
Enter the name referencing the virtual service.

The server computer in the LAN (Local Area Network) that will be
providing the virtual services.

The protocol used for the virtual service.

The port number of the service used by the Private IP computer.

The port number on the WAN (Wide Area Network) side that will
be used to access the virtual service.

The schedule of time when the virtual service will be enabled.
The schedule may be set to Always, which will allow the
particular service to always be enabled. Ifit is set to Time,
select the time frame for the service to be enabled. If the
system time is outside of the scheduled time, the service will
be disabled.

If you have a Web server that you wanted Internet users to
access at all times, you would need to enable it. Web
(HTTP) serveris on LAN (Local Area Network) computer
192.168.0.25. HTTP uses port 80, TCP.

Name: Web Server

Private IP: 192.168.0.25

Protocol Type: TCP

Private Port: 80

Public Port: 80

Schedule: always

20



Using the Configuration Menu (continued)
Advanced > Virtual Server continued

Virtual Servers List
Narne Prreate IP Protocol achedule
B Wirttual Server HTTP 192.168.0.25 TCP 804280 always ATl

J' Click on this icon to edit the virtual service

." ll Click on this icon to delete the virtual service

Example #2:

If you have an FTP server that you wanted Internet users to access by WAN port
2100 and only during the weekends, you would need to enable it as such. FTP
server is on LAN computer 192.168.0.30. FTP uses port 21, TCP.

Name: FTP Server
Private IP: 192.168.0.30
Protocol Type: TCP
Private Port: 21

Public Port: 2100

Schedule: From: 01:00AM to 01:00AM, Sat to Sun
All Internet users who want to access this FTP Server
must connect to it from port 2100. This is an example of

port redirection and can be useful in cases where there
are many of the same servers on the LAN network.

21



Using the Configuration Menu (continued)
Advanced >Applications

DI-624 |

g,.
=3

Wirte| Ganeer

Fillors

Frowall

Bz

Prrimraner

il

Some applications require multiple connections, such as Internet gaming, video
conferencing, Internet telephony and others. These applications have difficulties
working through NAT (Network Address Translation). Special Applications makes
some of these applications work with the VDI-624. If you need to run applications that
require multiple connections, specify the port normally associated with an application
in the “Trigger Port” field, select the protocol type as TCP or UDP, then enter the
public ports associated with the trigger port to open them for inbound traffic.

The VDI-624 provides some predefined applications in the table on the bottom of the

-‘:ﬂfr}glua G-
High-Speed 2.4GHz Wireless Routor

Epeckal .d.\wluumr; 15 ugad b e epplicaion s tat raeuin mauliple con rachone
T Erabled ™ [izsbled

Haria | Clear

TimerPot [ [

Trgger Type m

Public Par |

Public Typs TGP ';

2 9O
1.8 ik | Apply Concel Help
HAME Trgger Public

I~ Baitle net 6112 6112 L
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web page. Select the application you want to use and enable it.
Note! Only one PC can use each Special Application tunnel.

Name:

Trigger Port:

Trigger Type:
Public Port:

Public Type:

This is the name referencing the special application.

This is the port used to trigger the application. It can be either
a single port or a range of ports.

This is the protocol used to trigger the special application.

This is the port number on the WAN side that will be used to
access the application. You may define a single port or a
range of ports. You can use a comma to add multiple ports or
port ranges.

This is the protocol used for the special application.




Using the Configuration Menu (continued)

Advanced > Filters > IP Filters

D-Link

Buflding Networks for People

DI-624 l

‘Wirtual Server

* Applications

1]

Filters

¥ =
" Firewall

DMZ

" Performance

i

::dlr’Pﬁ |L:IE%’ —r="

High-Speed 2.4GHz Wireless Router
[ Home JWYYLIZNEE Tools

Filters are used to allow or deny LAN users from accessing the Internet.

talus Help

& |P Filters
 MAC Filters

 URL Blocking
' Daomain Blocking

IP Filters
Use IP Filters to deny LAN IP addresses access to the Internet.

€ Enabled © Disabled Cleat

P -]

Port I 4 |
Protocol Type ITCF' 'l

Schedule A|Way5

C
bt tirme |00 =] - |00 =] |am =] 1o 00 =] . [o0 =] [am =]
day|8un YImlSun vl
9 99O
IP Filter List Apply Cancel Help
IP Range Protocol Schedule
m = TCP 20:21 always Bl
| TCP 80 abways [l

Filters are used to deny or allow LAN (Local Area Network) computers from accessing
the Internet. The VDI-624 can be setup to deny internal computers by their IP or MAC
addresses. The VDI-624 can also block users from accessing restricted web sites.

IP Filters:

IP:

Port:

Protocol Type:

Schedule:

Use IP Filters to deny LAN IP addresses from accessing the
Internet. You can deny specific port numbers or all ports for
the specific IP address.

The IP address of the LAN computer that will be denied
access to the Internet.

The single port or port range that will be denied access to the
Internet.

Select the protocol type.
This is the schedule of time when the IP Filter will be enabled.
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Using the Configuration Menu (continued)

Advanced > Filters > URL Blocking

D-Link

Buflding Networks for People

-“AIP’Pﬁ IusE >
High-Speed 2.4GHz Wireless Router
DI-624

I m Advanced Tools Status Help

Filters

Filters are used to allow or deny LAN users from accessing the Internet.

—
Virtuat Savver O IP Filters @ URL Blocking
O MAC Filters O Domain Blocking

—
! Applications

URL Blocking

Block those URLs which contain keywords listed below.

Filters @ Enabled O Disabled

!laaaa

TR
Firewall

DMZ —

2 90O

Apply Cancel Help
Performance

i

URL Blocking is used to deny LAN computers from accessing specific web sites by
the URL. A URL is a specially formatted text string that defines a location on the
Internet. If any part of the URL contains the blocked word, the site will not be
accessible and the web page will not display. To use this feature, enter the text string
to be blocked and click Apply. The text to be blocked will appear in the list. To
delete the text, just highlight it and click Delete.

Filters- Select the filter you wish to use; in this case, URL Blocking
was chosen.

URL Blocking- Select Enabled or Disabled.

Keywords- Block URLs which contain keywords listed below.

Enter the keywords in this space.
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Using the Configuration Menu (continued)
Advanced > Filters > MAC Filters

Liliats ArPlus -
High-Speed 2.4GHz Wireless Router

DI-624 sm— - -
l m Advanced Tools Status

Filters are used to allow or deny LAN users from accessing the Internet.

IS Sorves O IP Filters © URL Blocking
® MAC Filters O Domain Elocking

"Applications

MAC Filters

Use MAC address to allow or deny computers access to the network.

© Disabled MAC Filters
@ Only allow computers with MAC address listed below to access the network
O Only deny computers with MAC address listed below to access the netwark

Filters
—

i Narme |MACitter 1 [ Clear]|
— ac s 0050 |- (@ |-[o1 |- |-l
DHCP Client | |
200
MAC Filter List Apply Cancel Help
Name MAC Address

Use MAC (Media Access Control) Filters to allow or deny LAN (Local Area Network)
computers by their MAC addresses from accessing the Network. You can either manually
add a MAC address or select the MAC address from the list of clients that are currently

connected to the Broadband Router.

Filters- Select the filter you wish to use; in this case, MAC filters was
chosen.

MAC Filters- Choose Disable MAC filters; allow MAC addresses listed be-
low; or deny MAC addresses listed below.

Name- Enter the name here.

MAC Address- Enter the MAC Address.

DHCP Client- Select a DHCP client from the pull-down list; click Clone to
copy that MAC Address.
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Using the Configuration Menu (continued)
Advanced > Filters > Domain Blocking

Building Networks for People

D-Link -AirlPlus i
Xorreme
High-Speed 2.4GHz Wireless Router
[ Home VYU Tools Status Help

Filters

Filters are used to allow or deny LAN users from accessing the Internet.

DI-624 l

PRy SaTver O IP Filters © URL Blocking
O MAC Filters @ Domain Blocking

! Applications

Domain Blocking

O Disabled

Filters @ Allow users ta access all domains except "Blacked Domains”
) Deny users to access all damains except "Permitted Domains”

i

e Permitted Domains
PREWON |www.d|ink corm|
i
DMZ
Blocked Domains e
i
w

Domain Blocking is used to allow or deny LAN (Local Area Network) computers from
accessing specific domains on the Internet. Domain blocking will deny all requests to a
specific domain such as http and ftp. It can also allow computers to access specific
sites and deny all other sites.

Filters- Select the filter you wish to use; in this case, Domain Blocking
) ) was chosen.
Domain Blocking-
Disabled- Select Disabled to disable Domain Blocking.
Allow- Allows users to access all domains except Blocked Domains.
Deny- Denies users access to all domains except
Permitted Domains.
Permitted
Domains- Enter the Permitted Domains in this field.

Blocked Domains- Enterthe Blocked Domains in this field.
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Using the Configuration Menu (continued)

Advanced > Firewall

=AirPlus c-
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Firewall Rules is an advanced feature used to deny or allow traffic from passing
through the VDI-624. It works in the same way as IP Filters with additional settings.
You can create more detailed access rules for the VDI-624. When virtual services are
created and enabled, it will also display in Firewall Rules. Firewall Rules contain all
network firewall rules pertaining to IP (Internet Protocol).

In the Firewall Rules List at the bottom of the screen, the priorities of the rules are
from top (highest priority) to bottom (lowest priority.)

Note:
The VDI-624 MAC Address filtering rules have precedence over the Firewall Rules.

Firewall Rules- Enable or disable the Firewall

Name- Enter the name

Action- Allow or Deny

Source- Enter the IP Address range
Destination- Enter the IP Address range; the Protocol;

and the Port Range

Schedule- Select Always or enter the Time Range.
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Using the Configuration Menu (continued)

Advanced > DMZ

D-Link

Building Networks for People

:'Alf'jpﬁ Il.é%, ="

High-Speed 2.4GHz Wireless Router
[ Home YUV I Tools Status Help

DI-624 l

-

DMZ (Demilitarized Zone) is used to allow a single computer on the LAN to be exposed to

the Internet.
Virtual Server

' Enabled & Disabled

IP Address 192 . 158.D.|D

* Applicalions

Filters 0 Q o

Apply Cancel Help

Firewall

Performance

If you have a client PC that cannot run Internet applications properly from behind the
VDI-624, then you can set the client up for unrestricted Internet access. It allows a
computer to be exposed to the Internet. This feature is useful for gaming purposes.
Enter the IP address of the internal computer that will be the DMZ host. Adding a
client to the DMZ (Demilitarized Zone) may expose your local network to a variety of
security risks, so only use this option as a last resort.

DMZ- Enable or Disable the DMZ. The DMZ (Demilitarized Zone)
allows a single computer to be exposed to the internet. By
default the DMZ is disabled.

IP Address- Enter the IP Address of the computer to be in the DMZ.
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Using the Configuration Menu (continued)

Advanced > Performance
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Beacon Interval-

RTS Threshold-

Fragmentation-

DTIM interval-

Preamble Type-

SSID Broadcast-

Beacons are packets sent by an Access Point to synchronize a
wireless network. Specify a value. 100 is the default setting and
is recommended.

This value should remain at its default setting of 2432. If inconsis-
tent data flow is a problem, only a minor modification should be
made.

The fragmentation threshold, which is specified in bytes, deter-
mines whether packets will be fragmented. Packets exceeding
the 2346 byte setting will be fragmented before transmission.
2346 is the default setting.

(Delivery Traffic Indication Message) 3 is the default setting. A
DTIM is a countdown informing clients of the next window for
listening to broadcast and multicast messages.

Select Short or Long Preamble. The Preamble defines the
length of the CRC block (Cyclic Redundancy Check is a com-
mon technique for detecting data transmission errors) for com-
munication between the wireless router and the roaming wire-
less network adapters. Note: High network traffic areas should
use the shorter preamble type.

Choose Enabled to broadcast the SSID across the network.
All devices on a network must share the same SSID (Service
Set Identifier) to establish communication. Choose Disabled
if you do not wish to broadcast the SSID over the network.
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Using the Configuration Menu (continued)

802.11g only mode-

CTS Mode-

Super G Mode-

Disabled-
Super G without
Turbo-

Super G with
Dynamic Turbo-

Super G with
Static Turbo-

Advanced > Performance (continued)

Select this mode to restrict your network to only those devices
that employ the 802.11g standard. Enabling this mode will en-
sure that you maintain the highest connectivity rate, unhampered
by any connection to an 802.11b device.

CTS (Clear To Send) is a function used to minimize collisions
among wireless devices on a wireless local area network (LAN).
CTS will make sure the wireless network is clear before a wire-
less client attempts to send wireless data. Enabling CTS will
add overhead and may lower wireless throughput.

None-  CTSistypically used in a pure 802.11g environment.
If CTS is setto “None” in a mixed mode environment
populated by 802.11b clients, wireless collisions may
occur frequently.

Always- CTS will always be used to make sure the wireless
LAN is clear before sending data.

Auto- CTS will monitor the wireless network and automati-
cally decide whether to implement CTS based on
the amount of traffic and collisions that occurs on
the wireless network.

Super G is a group of performance enhancement features that
increase end user application throughput in an 802.11g network.
Super G is backwards compatible to standard 802.11g devices.
For top performance, all wirelss devices on the network should
be Super G capable. Select either Disabled, Super G without
Turbo, Super G with Dynamic Turbo, or Super G with Static Turbo.

Standard 802.11g support, no enhanced capabilities.

Capable of Packet Bursting, FastFrames, Compression, and no
Turbo mode.

Capable of Packet Bursting, FastFrames, Compression, and
Dynamic Turbo. This setting is backwards compatible with non-
Turbo (legacy) devices. Dynamic Turbo mode is only enabled
when all nodes on the wireless network are Super G with Dy-
namic Turbo enabled.

Capable of Packet Bursting, FastFrames, Compression, and
Static Turbo. This setting is not backwards compatible with non-
Turbo (legacy) devices. Static turbo mode is always on and is
only enabled when all nodes on the wireless network is Super G
with Static Turbo enabled. 30



Using the Configuration Menu (continued)

Tools>Admin
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At this page, the VDI-624 administrator can change the system password. There are two
accounts that can access the Broadband Router's Web-Management interface. They
are admin and user. Admin has read/write access while user has read-only access. User
can only view the settings but cannot make any changes.

Administrator- admin is the Administrator login name
Password- Enter the password and enter again to confirm
User- user is the User login name

Password- Enter the password and enter again to confirm

Remote Management- Remote management allows the VDI-624 to be configured
from the Internet by a web browser. Ausername and password is still required to access
the Web-Management interface. In general, only a member of your network can browse
the built-in web pages to perform Administrator tasks. This feature enables you to per-
form Administrator tasks from the remote (Internet) host.

IP Address- The Internet IP address of the computer that has access to the Broadband
Router. If you input an asterisk (*) into this field, then any computer will be able to access
the Router. Putting an asterisk (*) into this field would present a security risk and is not
recommended.

Port- The port number used to access the Broadband Router.

Example- http://x.x.x.x:8080 where x.x.x.x is the WAN IP address of the Broadband
Router and 8080 is the port used for the Web-Mangement interface.
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Using the Configuration Menu (continued)

Time Zone-

Default
NTP Server-

Set the Time-

Daylight
Saving-

Tools > Time
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Select the Time Zone from the pull-down menu.

NTP is short for Network Time Protocol. NTP synchronizes com-
puter clock times in a network of computers.
This field is optional.

To manually input the time, enter the values in these fields for
the Year, Month, Day, Hour, Minute, and Second. Click Set Time.

To select Daylight Saving time manually, select enabled or dis-
abled, and enter a start date and an end date for daylight saving
time.
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Using the Configuration Menu (continued)

Tools > System

D-Link
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System Settings

Save Settings To Local Hard Drive

Admin A |

' Time ) :
Load Settings From Local Hard Drive

[ Browse |
System Load |
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* irmware

-
-

Restare To Factory Default Settings

Restora |

" Misc.

Help

The current system settings can be saved as a file onto the local hard drive. The saved
file or any other saved setting file can be loaded back on the Broadband Router. To reload
a system settings file, click on Browse to browse the local hard drive and locate the
system file to be used. You may also reset the Broadband Router back to factory set-
tings by clicking on Restore.

Save Settings to
Local Hard Drive- Click Save to save the current settings to the local Hard Drive

Load Settings from
Local Hard Drive- Click Browse to find the settings, then click Load

Restore to Factory
Default Settings-  Click Restore to restore the factory default settings
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Using the Configuration Menu (continued)

Ping Test-

Restart
Device-

Block
WAN
Ping-

UPNP-

Gaming
Mode-

Dynamic
DNS-

VPN
Pass
Through-

The Ping Test is used to
send Ping packets to test if
a computer is on the
Internet. Enter the IP Ad-
dress that you wish to Ping,
and click Ping.

Click Reboot to restart the
VDI-624.

If you choose to block WAN
Ping, the WAN IP Address
of the VDI-624 will not re-
spond to pings. Blocking the
Ping may provide some ex-
tra security from hackers.

Discard Ping from
WAN side-

Click Enabled to block the
WAN ping.
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To use the Universal Plug and Play feature click on Enabled. UPNP
provides compatibility with networking equipment, software and periph-
erals of the over 400 vendors that cooperate in the Plug and Play forum.

Gaming mode allows a form of pass-through for certain Internet Games.
If you are using Xbox, Playstation2 or a PC, make sure you are using
the latest firmware and Gaming Mode is enabled. To utilize Gaming
Mode, click Enabled. If you are not using a Gaming application, it is
recommended that you Disable Gaming Mode.

Dynamic Domain Name System is a method of keeping a domain name
linked to a changing IP Address. This is a useful feature since many
computers do not use a static IP address.

The VDI-624 supports VPN (Virtual Private Network) pass-through
for both PPTP (Point-to-Point Tunneling Protocol) and IPSec
(IP Security). Once VPN pass-through is enabled, there is no
need to open up virtual services. Multiple VPN connections can
be made through the VDI-624. This is useful when you have many

VPN clients on the LAN network.

PPTP- select Enabled or Disabled
IPSec- select Enabled or Disabled
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Using the Configuration Menu (continued)
Status > Device Info
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This page displays the current information for the VDI-624. It will display the LAN, WAN
and MAC address information.

If your WAN connection is set up for a Dynamic IP address then a Release button and
a Renew button will be displayed. Use Release to disconnect from your ISP and use
Renew to connect to your ISP.

If your WAN connection is set up for PPPoE, a Connect button and a Disconnect button
will be displayed. Use Disconnect to drop the PPPoE connection and use Connect to
establish the PPPOE connection.

This window will show the VDI-624’s working status:

WAN IP Address: WAN/Public IP Address
Subnet Mask: WAN/Public Subnet Mask
Gateway: WAN/Public Gateway IP Address
Domain Name Server: WAN/Public DNS IP Address
WAN Status: WAN Connection Status

LAN IP Address: LAN/Private IP Address of the VDI-624
Subnet Mask: LAN/Private Subnet Mask of the VDI-624

Wireless MAC Address: Displays the MAC address
SSID: Displays the current SSID
Channel: Displays the current channel
WEP: indicates whether WEP is enabled or disabled
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Using the Configuration Menu (continued)

Status > Log

D-Link
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High-Speed 2.4GHz Wireless Router
Home Advanced Tools Status Iﬂ!_

ArPlus e

Xrrene

View Log

Y features.
Device Info

Wiew Log displays the activities occurring on the DIE24. Click on Log Settings for advance

First Page Last Page Freyions | Nexll Clearl Log Settings | Help

page 1 of 1
Time

l.oq_
Deci27/2002 17:09:11
Deci27/2002 17:0%:11
Deci27/2002 17:0%:11

Dec/a?izo0z 17.0%:07
| Wireless Deci2?i2002 17:0%:07

Message Source Destination [Maote
DHCP Eequest success 10.80.1.%4
DHCT Request 10.80.1.94
DHCP Discower
System started
DHCP Discover

The Broadband Router keeps a running log of events and activities occurring on the
Router. If the device is rebooted, the logs are automatically cleared. You may save the log

files under Log Settings.

View Log- First Page - The first page of the log
Last Page - The last page of the log
Previous - Moves back one log page
Next - Moves forward one log page
Clear - Clears the logs completely
Log Settings - Brings up the page to configure the log
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Using the Configuration Menu (continued)

Status > Log > Log Settings
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—_—
Device Info
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Log Email Address | Send Mail Mow
- Lag Type . System Activity
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© Stats
V¥ Attacks
; " Dropped Packets
Wireless F Natice
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Apply Cancel Help

Not only does the Broadband Router display the logs of activities and events, it can be
setup to send these logs to another location.

SMTP Server/ The address of the SMTP server that will be used to send the
IP Address - logs.

. The email address to which the logs will be sent.
Email Address - Click on Send Mail Now to send the email.
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Using the Configuration Menu (continued)

Status > Stats
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High-Speed 2.4GHz Wireless Router

Status

Home Advanced Tols

il

o

Traffic Statistics

Traffic Statistics display Receive and Transmit packets passing through the DIFE24.

Refresh | Reset | O

Help
Receive Transmit
WAN 3964 Packets 277 Packets
LAN 1317 Packets 2321 Packets

WIRELESS 11g 553 Packets 0 Packets

The screen above displays theTraffic Statistics. Here you can view the amount of pack-
ets that pass through the VDI-624 on both the WAN and the LAN ports. The traffic
counter will reset if the device is rebooted.

Status > Wireless

D-Link

Building Networks for People

DI-624 l

' Device Info

pe——
" Log

Wireless

-AirPlus z
XorrenmE
High-Speed 2.4GHz Wireless Router

Home Advanced Tools Status m

Connected Wireless Client List

9

Help

The Wireless Client table below displays Wireless clients Connected to the AP
(Access Point).
Connected Tima

MAC Address Mode

The wireless client table displays a list of current connected wireless clients. This
table also displays the connection time and MAC address of the connected wireless

client.

Click on Help at any time, for more information.
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Networking Basics

Using the Network Setup Wizard in Windows XP

In this section you will learn how to establish a network at home or work, using

Microsoft Windows XP.

Note: Please refer to websites such as http://www.homenethelp.com

and http://www.microsoft.com/windows2000 for information about networking
computers using Windows 2000, ME or 98.

Go to Start>Control Panel>Network Connections
Select Set up a home or small office network

Network Setup Wizard

Wizard

network. With a nebwork, pou can:

+ Share an Internet connection

+ Set up Intermet Connection Firewall
+ Share filez and folders

+ Share a printer

To continue, click Mext,

Welcome to the Network Setup

Thiz wizard will help you set up this computer o run on your

Mest »

[ Cancel

When this screen appears, Click Next.
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Networking Basics

Please follow all the instructions in this window:

Network Setup Wizard

Before you continue.__

Before you continue, review the Shecklist for creating a netwarks.

Then, complete the following steps:

+ Inztall the netwark. cards, modems, and cables.

+ Turn on all computers, printers, and external modems.
+ Cannect to the Intemet.

“When you click Mest, the wizard will search for a shared Intemet connection on wour network.

RN BT

Click Next.

In the following window, select the best description of your computer. If your computer
connects to the internet through a gateway/router, select the second option as shown.

Metwork Setup Wizard

Select a connection method.

Select the statement that best describes thiz camputer:

() Thiz computer connects directly to the Intermet. The other computers on my network connect
to the Internet through this computer.

Wiew an example.

@gThis computer connects to the Internet through another computer on my network or through
i3 rezidential gateway,
example.

() Other

Learn mare about home or small office nebwork configurations.

r—

< Back l Mext > ' Cancel

Click Next.
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Networking Basics

Enter a Computer description and a Computer name (optional.)

Click Next.

Enter a Workgroup name. All computers on your network should have the same

Network Setup Wizard
Give this computer a description and name.

(Qomputer deszcriphion: Mary's Computer

s

Examples: Family Room Computer or Monica's Computer

[ Computer name: Office ]
Evamples. FAMILT of MONICE

The current computer name iz Office

Leam maore about computer names and descriptions.

< Back l Mext = ' Cancel

Workgroup name.

Click Next.

Nebtwork Setup Wizand

Mame your network.

Marme your hebwark. by specifying a workgroup name belaw. All computers o your netwaork,
should have the same workgroup name.

Workaroup name: Accounting
E samples: HOME or OFFICE

< Back Mest > Cancel
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Please wait while the Network Setup Wizard applies the changes.

Network Setup Wizard

Ready to apply network sethings..

The wizard will apply the following settings. Thiz process may take a few minutes to complate
and cannot be internupted,

Settings:
Metwork zettings: A
Computer descrption; Mary's Computer
Camputer narme: Office
workgroup name: Accounting
The Shared Dacuments falder and ary printers connected ta thiz computer have been
shared.
v

To apply these settings, click Nest.

’ < Back ﬂ Mext > i[ Cancel
a4

When the changes are complete, click Next.

Please wait while the Network Setup Wizard configures the computer.
This may take a few minutes.

Metwork Setup Wizand

Please wait.__

Pleaze vaait while the wizard configures this computer for home or small office networking. This
process may take a few minutes.

3 pg b, )




Networking Basics

In the window below, select the option that fits your needs. In this example, Create a
Network Setup Disk has been selected. You will run this disk on each of the

computers on your network. Click Next.

Network Setup Wizard

You're almost done...

® - You need to run the Metwork Setup 'wizard once on each of the computers on pour
\!1) network. To run the wizard on computers that are not running *Windows XP, you can use
the Windows =P CD or a Metwork Setup Digk.

“w'hat do you want to do?

@EEreate a Metwork Setup Disk:

() Use the Netwark Setup Disk | alieady have
() Use my Windows XP CD

(2 Just finish the wizard; | don't need ta run the wizard on ather computers

Insert a disk into the Floppy Disk Drive, in this case drive A.

Network Setup Wizard

Insert the disk you want to use_

Inzert a disk the inta the follawing disk dive, and then click Mest.
3% Floppy [4:)

If you want to format the disk, click Format Disk.

Click Next.
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X]

Copying...

L~ LV

Flzase wait while the wizard copies files...

[ ) Cancel |

Please read the information under Here’s how in the screen below. After you complete
the Network Setup Wizard you will use the Network Setup Disk to run the Network

Setup Wizard once on each of the computers on your network. To continue click Next.

Metwork Setup Wizand

To run the wizard with the Network Setup Disk. .. %

i Complete the wizard and restart thiz computer. Then, use the Metwork Setup Disk to run
\\J) the Metwork. Setup Wizard once on each of the ather computers on your network,

Here's how:
1. Inzert the Metwork Setup Dizk into the nest computer you want to netwark.

2. Open My Computer and then open the Network, Setup Disk.
3. Double-click "netsetup. "
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Please read the information on this screen, then click Finish to complete the
Network Setup Wizard.

Hetwork Setup Wizand

Completing the Network Setup
Wizard

You have successfully set up thiz computer far home ar small
office networking.

For help with home or zmall office nebworking, ree the
fallowing topics in Help and Suppaort Center:

+ Lzing the Shared Documents folder

To zee other compukers on your nebwark, click Start, and then
click My Metwork, Places.

To cloze thiz wizard, click Finish.

| <Back Firish |

The new settings will take effect when you restart the computer. Click Yes to restart
the computer.

System Settings Change

P ¥ou musk restart your computer before the new settings will kake effect,

Do you wank to restart your computer now’?

i es | [ Mo

You have completed configuring this computer. Next, you will need to run the Network
Setup Disk on all the other computers on your network. After running the Network

Setup Disk on all your computers, your new wireless network will be ready to use.
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Naming your Computer

To name your computer, please follow these directions:In Windows XP:

B Click Start (in the lower left corner of the screen)

B Right-click on My Computer

B Select Properties and click

. Internet
Inkernet Explorer

™ E-mail

8 Outlook Express

Command Prompt

ﬁ IM5M Explorer

@ Windows Media Player
@ Windows Mavie Maker
@ Tour Windows xP

? Files and Settings Transfer
- ‘Wizard

___] My Documents
:3 My Recent Documents *
__'E} My Pictures
» My Music
l My Computer |
= Open
t:] My Metwork  Explore
Search...

G Contral Pane]  Manage

Map Metwork Drive. ..
e_; Connect To Disconnect Metwork Drive. ..

L,:é Frinters and F Show on Deskkop
Rename

@) Helo ond Su@

B Selectthe Computer
Name Tab in the System
Properties window.

M You may enter a
Computer Description if

you wish;

optional.

this field is

m Torename the computer
and join a domain, Click

Change.

System Properties

Syztem Restg patic Updates Remote
General H ComputerName Hardware Advanced

';J Windows uses the following information to identify wour computer
o the netvaork.

Computer description:

For example: ""Kitchen Computer” or "Mary's
Computer",

Full computer name:  Office

Workgroup: Accounting

To use the Metwork Identification Wizard bo join a Wetwork D
daomain atd create a local uzer account, click Metwark —

0.

To rename this computer or join a domain, click Change. -
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Naming your Computer

B |n this window, enter the Computer, Mame Changes
Computer name.

Y'ou can change the name and the membership of thiz
computer. Changes may affect access to network resources.

B Select Workgroup and enter
the name of the Workgroup.

LComputer name:
Office
B All computers on your network ]
Full computer name:
must have the same Office
Workgroup name.

More. .

B Click OK tdember of
. () Domair:

(=) Workgroup:
Accounting

[ ox ) teen

Checking the IP Address in Windows XP

The wireless adapter-equipped computers in your network must be in the same IP Ad-
dress range (see Getting Started in this manual for a definition of IP Address Range.) To
check on the IP Address of the adapter, please do the following:

B Right-click on the Disable
Connectionicon ;
Repair

in the task bar.
Wiew Aywailable Wireless Mebworks

Cpen Metwork Connections
B Click on Status.
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Checking the IP Address in Windows XP

This window will appear.

Wireless Netwaork Connection 7 Status |E||X|

General i Suppart '

Internet Pratocal [TCRAR)

Azzigned by DHCP

192.168.0.114 ]

[ | Click the
Support tab Addrezz Type:
[ IF Address:
Subnet Mask:

Default Gateway:

[ | Click Close

255, 2585.255.0
192.168.0.1

Detailz. ..

—_—
LCloze

Assigning a Static IP Address in Windows XP/2000

Note: Residential Gateways/Broadband Routers will autom

atically assign IP Addresses

to the computers on the network, using DHCP (Dynamic Host Configuration Protocol)
technology. If you are using a DHCP-capable Gateway/Router you will not need to assign

Static |IP Addresses.

If you are not using a DHCP capable Gateway/Router, or you need to assign a Static IP

Address, please follow these instructions:

[ Go to Start '__@ Tour Windows XP

1‘5 Paink

; | Files and Settings Transfer
. - Wizard
u Double-click on

Control Panel
All Programs D

E—- Conkral Panel

E::é. Printers and Faxes

.t_’_) Help and Suppart

Search

ERun...

ﬁ| Lag CFF |6| Turn OFF Computer
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Assigning a Static IP Address in Windows XP/2000

B Control Panel

File Edit “iew Favorites Tools  Help
N —
k) Back. J ﬁ j"‘) Search H’j‘ Folders
Address G Control Panel
- %, Accessibility Options
ﬂ’ Control Panel & S Add Hardware
. D bl I k Add or Remove Programs
oupie-click on G, Switch to Cabegory Yiew 4 Administrative Tools
N etwor k Date and Time
Connections See Also
° Uinden Usikle & Game Contralers
@) Help and Support P Internet Options
» Phone and Modem Options
3 Power Opkions
- 3Printers and Faxes
g Reegional and Language Options
=% Scanners and Cameras
‘) Scheduled Tasks
L Sounds and Audio Devices
e, Taskbar and Start Menu
User Accounts
% Network Connections
File Edt View Favorites Tools  Advarced  Help
Qe - Q  F Osench [ rolcers
& Hetwork Cannections
- 7 Mame
Network Tasks k LAN or High-Speed Internet
Create a new
connection
i i ) Setupah il
B Right-click on Local Area - T s
i @ Disable this network
Connections dence i Connestions

f\ Repair this connection
Create Shorteut
i Rename this connection
& View status of this
connection
Change settings of this
connection

Delete
Rename

B Double-click on
Properties Other Places

@ Control Panel b |
\'_} My Network Places

(L3 My Documents

J My Computer

Details
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Assigning a Static IP Address
in Windows XP/2000

B Click on Internet Protocol
(TCP/IP)

B Click Properties

B Inputyour IP address and
subnet mask. (The IP
Addresses on your network
must be within the same
range. For example, if one
computer has an IP Address
0f 192.168.0.2, the other
computers should have IP
Addresses that are
sequential, like 192.168.0.3
and 192.168.0.4. The subnet
mask must be the same for
all the computers on the
network.)

B Inputyour DNS server
addresses. (Note: Ifyou
are entering a DNS
server, you must enter the
IP Address of the Default
Gateway.)

The DNS server information will be supplied

by your ISP (Internet Service Provider.)

B Click OK

)X

- Local Area Connection 7 Properties

Gereral | Advanced

Connect using:

ES  D-Link DWL-AB50

Thiz connection uzes the following items:

% Clignt for Microsoft Nebwaorks

S File and Printer Sharing for Microzoft Netwaorks
Bl 5 Packet Scheduler
Intemet Pratocal [TCPAR) )

Inztall...

[ escription

Coe |

Tranzmizzion Control Protocol/Intemet Protocal. The default
wide area netwark. pratacal that provides comrunication
across diverse interconnected netwark s,

[ Show icon in notification area when connected

oK ] [ Cancel

2]

Internet Protocol (TCP/IP) Properties

General

Y'ou can get IP settings assigned automatically if your network, supports
this capability. Othenwize, you need to ask your network. administrator for
the appropriate [P settings.

() Obtain an IF address automatically

‘@ Uze the following IP address: '
P addiess: 192.168 . 0 . 2
Subret mask: 280 .28 2850 0

Default gateway:

(@ Usze the following DNS server addresses:)

Preferred DNS server:

Alternate DMS server

(-
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Assigning a Static IP Address with Macintosh OSX

an [=)
808
B Go to the Apple Menu and se- m m =@ oe =
lect System Preferences R st e St el o ey
LN T

[ | i e,
Click on Network = @ a

. £
Saviem
258 082
‘88 MNetwark =

M SelectBuilt-in Ethernetinthe '« = & @ O
Show pull-down menu

Location:  Automatic -a

Show:  Bullt-in Ethernet

DHLP Router
]

figure pull-down menu Configure Using DHCP
UHng boole Servers Optionall
1P Address -
(Provided by OHCP Serven)

Subnet Mask: 255.255.255.0

Router: 19216801 Search Domains Dptignall

DHCP Cliens 1D
Opeional)
Lample: agple.com. sasthlinknet
Ethernet Address:

@ Click the lotk to prevent further changes. A "~
‘88 Nerwark (=)

w AN

Show Al Displays Sound Network Startup Disk

Location: [Amomatic 9]

B Inputthe Static IP Address, - n =

the Subnet Mask and the s EEA LA L
Router IP Address in the ap- Contaure: sty __T9)

Damain Name Servers Optiosall

propriate fields m— Domaln Name Servers (Cotsasd

1P Address. | 182.166.0.2

Subnet Mask:  255.255.255.0

Router 19216801 Search Domains iprionaly

Lxample: agnle.com. sarthlink.net
Ethernet Address. 00.09.93.75.de-5a

B Click Apply Now

= f o
(@) Click the lock 1o prevent further changes. {_Apply Now -
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Selecting a Dynamic IP Address with Macintosh OSX

Go to the Apple Menu and select

System Preferences

Click on Network

Select Built-in Ethernet in the
Show pull-down menu

Select Using DHCP in the
Configure pull-down menu

Click Apply Now

The IP Address, Subnet
mask, and the Router’s IP
Address will appear in a few
seconds

e =
« = H4@ B
[ T v ey
Personsl
m MW E@E e a8 @
e I e
tardmare
e = ¢ S 4
Conrivac  Dupie e b e e
Intereet & Metz
= 22
—— QueiTie By
utem
9 )y & 4
Cmic  BewkTems  Stmes  Seh  emeDi e
00 Nework =
« EH A4 3
Show ANl Dwplays Sownd Network Stariup Disk
Location: | Automatic 5
Show: | Bullt-in Ethernet i)
——- = o 3
—_— Manually L
@EEIIIL: + Using OWC
Servers iDptionall
IP Address:
(Provided by DHCP Server)
Subnet Mask: 255,255.255.0
Router 19216801 Sebrch Donring —— iopromh
DHCP Cliant 10:
@atsonal)
Fram, e com, rarthlink ne
Ethernet Addrecs i ot 5 :
2\ e
(@) Click the iock to prevent furher changes. Apply
[-):] Netwark [=]
e -
Show All  Displays Scund Network Stastup Disk
Location: | Automatic T‘
Show: | Bullt-in Ethernet [ ]
f ﬁi| PPRoE | AppleTalk | Proxies
Configure: | Using DHCP G
Domain Name Servers Optianali
IP Address: 192.168.0160
iPravided by GHCP Serves)
Subnet Mask 255.255.255.0
I ‘Search Domaing Optianal)
DHCP Clierit 10:
(opnianal)
Example. apple.com, earthlink net
Ethernet Address: 00.06.96.79.de 5a
(&) Chck the lnck to prevent further changes. " Apply Now



Networking Basics
Checking the Wireless Connection by Pinging in Windows XP and

2000

m GotoStart >Run > BGE
type cmd. Awindow RS 1g}n:d;%;;aé?ﬁ;é?ﬁ«ﬁr% 35?3]
Similar to '[hIS one IF:\Documents and Settings:\lah4>ping 192_168.0.58
will appear Type Pinging 192.168.8.50 with 32 bytes of data:
ping
XXX XXX XXX . XXX, Qo 5 4 tose
where xxx is the IP e 5ng. Raienct dit heseEe
Address of the [P \Documents and Settingsslahd>_

Wireless Router or
Access Point. A
good wireless
connection will show
four replies from the
Wireless Router or
Acess Point, as
shown.

Checking the Wireless Connection by Pinging in Windows Me
and 98

B Goto Start > Run "5 M5-DOS Prompt =0l x|
> type command.
A window similar to
this will appear.
Type ping
XXX XXX . XXX XXX
where xxx is the IP
Address of the
Wireless Router or
Access Point. A
good wireless
connection will
show four replies
from the wireless
router or access
point, as shown.
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Troubleshooting

This Chapter provides solutions to problems that can occur during the installation and
operation of the VDI-624 Wireless Broadband Router. We cover various aspects of the
network setup, including the network adapters. Please read the following if you are having
problems.

Itis recommended that you use an Ethernet Connection to configure the VDI-624
Wireless Broad Band Router.

1.The computer used to configure the VDI-624 cannot access the
Configuration menu.

B Check that the Ethernet LED on the VDI-624 is ON. If the LED is not
ON, check that the cable for the Ethernet connection is securely
inserted.

B Checkthat the Ethernet Adapter is working properly. Please see
item 3 (Check that the drivers for the network adapters are
installed properly) in this Troubleshooting section to check that

the drivers are loaded properly.

B Checkthatthe IP Address is in the same range and subnet as the
VDI-624. Please see Checking the IP Address in Windows XP in
the Networking Basics section of this manual.

Note: The IP Address of the VDI-624 is 192.168.0.1. All the computers on the
network must have a unique IP Address in the same range, e.g., 192.168.0.x.
Any computers that have identical IP Addresses will not be visible on the
network. They must all have the same subnet mask, e.g., 255.255.255.0

B Do aPing test to make sure that the VDI-624 is responding. Go to
Start>Run>Type Command>Type ping 192.168.0.1. Asuccessful
ping will show four replies.

| = EAWINDOWS\System32\cmd.exe HE E

[E:\>ping 192.168.8.1

[Pinging 192.168.8.1 with 32 hytes of data: NOte: |f yOLI have

TTL=128

e changed the default IP
TTL-428 Address, make sure to
ping the correct IP
Address assigned to the

VDI-624.
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Troubleshooting

2. The wireless client cannot access the Internet in the
Infrastructure mode.

Make sure the wireless client is associated and joined with the correct Access
Point. To check this connection: Right-click on the Local Area Connection icon
in the taskbar> select View Available Wireless Networks. The Connect to
Wireless Network screen will appear. Please make sure you have selected the

correct available network, as shown in the illustrations below.

The following netwark(s) are available. To access a netwark,. select

Disable it from the list, and then click Connect.

Status

Repair Available nebwork s

1 alan ~

Wigw Available W 55 Metworks b odan

Zipen Metwork Connections dEfau“ 2
nin

ﬂitg

If you are having difficulty connecting to a netwark, click Advanced.

[ Connect ][ Cancel ]

B Check that the IP Address assigned to the wireless adapter is within the
same IP Address range as the access point and gateway. (Since the
VDI-624 has an IP Address of 192.168.0.1, wireless adapters must have
an IP Address in the same range, e.g., 192.168.0.x. Each device must
have a unique IP Address; no two devices may have the same IP
Address. The subnet mask must be the same for all the computers on
the network.) To check the IP Address assigned to the wireless adapter,
double-click on the Local Area Connection icon in the taskbar >
select the Support tab and the IP Address will be displayed. (Please
refer to Checking the IP Address in the Networking Basics section of
this manual.)

B Ifitis necessary to assign a Static IP Address to the wireless adapter,
please refer to the appropriate section in Networking Basics. If you are
entering a DNS Server address you must also enter the Default
Gateway Address. (Remember that if you have a DHCP-capable router,
you will not need to assign a Static IP Address. See Networking

Basics: Assigning a Static IP Address.)
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Troubleshooting

3. Check that the drivers for the network adapters are

installed properly.
You may be using different network adapters than those illustrated here, but this
procedure will remain the same, regardless of the type of network adapters you are

using.
g T’) Windows Media Player Open I
Explore
B’ Control P Search...
Manage
e‘ Conneck
= Map MNetwork Drive.,,

|lé Printers 2 Disconnect Network Drive. .,
w Show on Deskhop
9) Help and  Rename
[ ] Go to Start > My ) Zearch
Computer >
Properties O ..

All Programs D

Turn OFf Computer

4 start

System Properties

B Select the
Hardware | System Restore || Automat!c i D Remote
Tab | General || Computer Mame ¢ H Advanced

Add Hardware ‘wizard
i The Add Hardware “Wizard helps you install hardware.

Add Hardware ‘#izard

Device Manager

B Click Device
Manager

The Device Manager lists all the hardware devices installed
on your computer. Use the Device Manager to change the
properties of any device.

D e G
[ Diriver Signing ] [( Device Manager 3 ]
ST

Hardware Profiles

Hardware profiles provide a way for you to set up and store
different hardware configurations.

’ Hardware Profiles ]

ak, H Cancel ] Apply




Troubleshooting

B Double-click
on Network
Adapters

B Right-click on D-Link
AirPlus VDWL-G650
Wireless Cardbus
Adapter (In this example
we use the VDWL-G650;
you may be using other
network adapters, but the
procedure will remain the
same.)

B Select Properties
to check that the
drivers are in-
stalled properly

B Lookunder Device
Status to check that the
device is working

properly

B Click OK

£/ Device Manager

File Action Wew Help
8 ® 8 <Ra

=&, pmTEST
+ @, Eatteries
+ j Computer
+|- g Disk drives
- fg Display adapters
+- (=) Floppy disk contrallers
+ _ﬁ. Floppy disk drives
+- (=) IDE ATASATAPT contrallers
+- 2z Keyboards
+ ) Mice and other pointing devices
+ L Modems
+- 73 Monitors
=¥ Mebwork adapters

21 D-Link AirPlus DWL-G650

+ - |® PCMCIA adapters

+- ¢ Parts (COM & LPT)

+ %% Processors

+- @, sound, video and game controllers

+ Swstem davices
+ Universal Serial Bus controllers

D-Link AirPlus DWL-G650 Wireless Cardbus Adapter

RIX

General | Advanced | Settings | Driver  Resources

:_:_.--.I D-Link AirPlus DWL-G650 Wireless Cardbus Adapter

Device type: Metwork, adapters
M arufacturer: D-Link
Location: PCl busz 5, device 0, function 0

Dewice status

This device is warking properly.

If pou are having problems with thiz device, click Troubleshoot to
start the troubleshooter.

Troubleshaoot...

Device uzage:

Use thiz device [enable] A

l Ok ' Cancel
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Troubleshooting

4. What variables may cause my wireless products
to lose reception?

D-Link products let you access your network from virtually anywhere you want. However,
the positioning of the products within your environment will affect the wireless range.
Please refer to Installation Considerations in the Wireless Basics section of this manual
for further information about the most advantageous placement of your D-Link wireless
products.

5. Why does my wireless connection keep dropping?

B Antenna Orientation- Try different antenna orientations for the VDI-624. Try to
keep the antenna at least 6 inches away from the wall or other objects.

W Ifyou are using 2.4GHz cordless phones, X-10 equipment or other home secu-
rity systems, ceiling fans, and lights, your wireless connection will degrade dra-
matically or drop altogether. Try changing the Channel on your Router, Access
Point and Wireless adapter to a different Channel to avoid interference.

B Keep your product away (at least 3-6 feet) from electrical devices that generate
RF noise, like microwaves, monitors, electric motors, etc.

6. Why can’t | get a wireless connection?

If you have enabled Encryption on the VDI-624, you must also enable encryption on all
wireless clients in order to establish a wireless connection.

B For 802.11g, the Encryption settings are: 64 or 128 bit. Make sure that the
encryption bit level is the same on the Router and the Wireless Client.

B Make sure that the SSID on the Router and the Wireless Client are exactly the
same. Ifthey are not, wireless connection will not be established.

B Move the VDI-624 and the wireless client into the same room and then test the
wireless connection.

B Disable all security settings. (WEP, MAC Address Control)
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Troubleshooting

6. Why can’t | get a wireless connection? (continued)

Turn off your VDI-624 and the client. Turn the VDI-624 back on again, and then
turn on the client.

Make sure that all devices are set to Infrastructure mode.

Check that the LED indicators are indicating normal activity. If not, check that the
AC power and Ethernet cables are firmly connected.

Check that the IP Address, subnet mask, gateway and DNS settings are cor-
rectly entered for the network.

If you are using 2.4GHz cordless phones, X-10 equipment or other home security
systems, ceiling fans, and lights, your wireless connection will degrade dramati-
cally or drop altogether. Try changing the Channel on your VDI-624, and on all the
devices in your network to avoid interference.

Keep your product away (at least 3-6 feet) from electrical devices that generate
RF noise, like microwaves, monitors, electric motors, etc.

7. 1 forgot my encryption key.

Reset the VDI-624 to its factory default settings and restore the other devices on
your network to their default settings. You may do this by pressing the Reset
button on the back of the unit. You will lose the current configuration settings.
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Troubleshooting

8. Resetting the VDI-624 to Factory Default Settings

After you have tried other methods for troubleshooting your network, you may
choose to Reset the VDI-624 to the factory default settings. Remember that D-
Link AirPro products network together, out of the box, at the factory default
settings.

Reset

To hard-reset the VDI-624 to Factory Default Settings, please do the following:

B | ocate the Reset button on the back of the VDI-624
B Use a paper clip to press the Reset button

B Hold for about 10 seconds and then release

m After the VDI-624 reboots (this may take a few minutes)
it will be reset to the factory Default settings
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Technical Specifications

Standards
B |EEE802.11g
B |EEE802.11b

m |EEE802.3
m |EEE802.3u
VPN Pass Through/ Multi-Sessions
m PPTP
B L2TP
B [PSec

Device Management

B Web-Based- Internet Explorer v6 or later; Netscape Navigator v6
or later; or other Java-enabled browsers

B DHCP Server and Client

Advanced Firewall Features

B NAT with VPN Passthrough (Network Address Translation)
MAC Filtering
IP Filtering
URL Filtering
Domain Blocking
Scheduling
Wireless Operating Range
B Indoors — up to 328 feet (100 meters)
B Outdoors — up to 1312 feet (400 meters)
Operating Temperature
B 32°F to 131°F (0°C to 55°C)

Humidity:
B 95% maximum (non-condensing)

Safety and Emissions:
B FCC

Wireless Frequency Range:
B 24GHzto2.462GHz
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Technical Specifications

LEDs:
Power

WAN
LAN (10/100)
WLAN (Wireless Connection)

Physical Dimensions:

B L =7.56Iinches (192mm)
B W =4.65 inches (118mm)
B H=1.22inches (31mm)

Wireless Transmit Power:
B 15dBm +2dB

Security:

B 802.1x

B  WPA- WiFi Protected Access
(64-,128-WEP with TKIP, MIC, IV Expansion, Shared Key
Authentication)

External Antenna Type:
B Single detachable reverse SMA

Modulation Technology:
B Orthogonal Frequency Division Multiplexing (OFDM)

Power Input:
B Ext. Power Supply DC 5V, 2.5A

Weight:
B 10.8 oz. (0.3kg)
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Technical Specifications

Wireless Data Rates with Automatic Fallback:

Receiver

108 Mbps
54 Mbps
48 Mbps
36 Mbps
24 Mbps
18 Mbps
12 Mbps
11 Mbps
9 Mbps
6 Mbps
5.5 Mbps
2 Mbps

1 Mbps

Sensitivity:

108Mbps

54Mbps OFDM, 10% PER, -68dBm
48Mbps OFDM, 10% PER, -68dBm
36Mbps OFDM, 10% PER, -75dBm
24Mbps OFDM, 10% PER, -79dBm
18Mbps OFDM, 10% PER, -82dBm
12Mbps OFDM, 10% PER, -84dBm
11Mbps CCK, 8% PER, -82dBm
9Mbps OFDM, 10% PER, -87dBm
6Mbps OFDM, 10% PER, -88dBm
5.5Mbps CCK, 8% PER, -85dBm
2Mbps QPSK, 8% PER, -86dBm
1Mbps BPSK, 8% PER, -89dBm
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Frequently Asked Questions

Why can’t | access the web based configuration?

When entering the IP Address of the VDI-624 (192.168.0.1), you are not connecting
to the Internet or have to be connected to the Internet. The device has the utility built-
in to a ROM chip in the device itself. Your computer must be on the same IP subnet
to connect to the web-based utility.

To resolve difficulties accessing a web utility, please follow the steps below.

Step 1 Verify physical connectivity by checking for solid link lights on the device. If
you do not get a solid link light, try using a different cable or connect to a different
port on the device if possible. If the computer is turned off, the link light may not be
on.

What type of cable should | be using?

The following connections require a Crossover Cable:
Computer to Computer

Computer to Uplink Port

Computer to Access Point

Computer to Print Server

Computer/XBOX/PS2 to DWL-810
Computer/XBOX/PS2 to DWL-900AP+

Uplink Port to Uplink Port (hub/switch)

Normal Port to Normal Port (hub/switch)

The following connections require a Straight-through Cable:
Computer to Residential Gateway/Router

Computer to Normal Port (hub/switch)

Access Point to Normal Port (hub/switch)

Print Server to Normal Port (hub/switch)

Uplink Port to Normal Port (hub/switch)

Rule of Thumb:
"If there is a link light, the cable is right.”
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

What type of cable should | be using? (continued)

What’'s the difference between a crossover cable and a straight-through
cable?

The wiring in crossover and straight-through cables are different. The two types
of cable have different purposes for different
LAN configurations. EIA/TIA 568A/568B

. . 1 White-Green
define the wiring standards and allow for g gﬁan o
two different wiring color codes as 1 Blue o l4®
illustrated in the following diagram. g ‘g—:gi;;flue
. . 7 White-Brown
*The wires with colored backgrounds may 8 Brown

have white stripes and may be denoted 5684 CABLE END
that way in diagrams found elsewhere. ; White-Orange
How to tell straight-through cable from 3 3;;1'3_‘:3,%“
. 4 BI
acrossover cable: _ B Blue
The main way to tell the difference 6 Green
between the two cable types is to compare 7 hite Brown
the wiring order on the ends of the cable. If
the wiring is the same on both sides, it is

5688 CABLE END
straight-through cable. If one side has opposite wiring, it is a crossover cable.

All you need to remember to properly configure the cables is the pinout order of
the two cable ends and the following rules:

A straight-through cable has identical ends

A crossover cable has different ends

It makes no functional difference which standard you follow for straight-through
cable ends, as long as both ends are the same. You can start a crossover cable
with either standard as long as the other end is the other standard. It makes no
functional difference which end is which. The order in which you pin the cable is
important. Using a pattern other than what is specified in the above diagram
could cause connection problems.

When to use a crossover cable and when to use a straight-through cable:
Computer to Computer — Crossover

Computer to an normal port on a Hub/Switch — Straight-through

Computer to an uplink port on a Hub/Switch - Crossover

Hub/Switch uplink port to another Hub/Switch uplink port — Crossover
Hub/Switch uplink port to another Hub/Switch normal port - Straight-through
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

Step 2 Disable any Internet security software running on the computer. Software
firewalls like Zone Alarm, Black Ice, Sygate, Norton Personal Firewall, etc. might
block access to the configuration pages. Check the help files included with your
firewall software for more information on disabling or configuring it.

Step 3 Configure your Internet settings.

Go to Start>Settings>Control Panel. Double click
the Internet Options Icon. From the Security tab,
click the button to restore the settings to their
defaults.

Click the Connection tab and set the dial-up
option to Never Dial a Connection. Click
the LAN Settings button.

Nothing should be checked. Click OK.

Go to the Advanced tab and click the
button to restore these settings to their
defaults.

Click OK. Go to the desktop and close any open
windows.
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

Step 4 Check your IP Address. Your computer must have an IP Address in the
same range of the device you are attempting to configure. Most D-Link devices use
the 192.168.0.X range.

How can | find my IP Address in Windows 95, 98, or
ME?

Step 1 Click on Start, then click on Run.

Step 2 The Run Dialogue Box will appear. Type winipcfg in the window as shown
then click OK.
Run HE

Tupe the name of & program, folder, or document, and
Wwindows will oper it for yo.

Open: |winipcfg j

ok i Cancel | Browse.. I

Step 3 The IP Configuration window will appear, displaying your Ethernet
Adapter Information.

M Select your adapter from the drop down menu.

M If you do not see your adapter in the drop down menu, your adapter is
not properly installed.

E IP Configuration [ (=]

— Ethemnet Adapter Infoimation

Default Gateway
ok I EElease | Fenew |

Felease All | Renew All | Hore Info => |

Step 4 After selecting your adapter, it will display your IP Address, subnet
mask, and default gateway.
Step 5 Click OK to close the IP Configuration window.
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

Step 4 (continued) Check your IP Address. Your computer must have an IP Address
in the same range of the device you are attempting to configure. Most D-Link devices
use the 192.168.0.X range.

How can | find my IP Address in Windows 2000/XP?

Step 1 Click on Start and select Run.

Step 2 Type cmd then click OK.
Run @ .-

I Twpe the name of a program, Folder, document, ar
Internet resource, and Windows will open it Far wau,

ern: | cmd | |

i

[ K H Cancel H Browse. .. ]

Step 3 From the Command Prompt, enter ipconfig. It will return your IP
Address, subnet mask, and default gateway

WINNT', system32, CMD.EXE

Microsoft Windows 20AA [Uersion 5.88
(C» Copyright 1985-280@ Microsoft Corp.

D:~>ipconfig
Windows 2888 IP Configuration
Ethernet adapter Local Area Connection:

Connection—specific DHS Suffix . =
IP Addre : 192.168.08.174

Subnet Mask T 255.255.255.@
: 192.168.8.1

Step 4 Type exit to close the command prompt.
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

Step 4 (continued) Check your IP Address. Your computer must have an IP
Address in the same range of the device you are attempting to configure. Most D-Link
devices use the 192.168.0.X range.

Make sure you take note of your computer’s Default Gateway IP Address. The Default
Gateway is the IP Address of the D-Link router. By default, it should be 192.168.0.1.

How can | assign a Static IP Address in Windows XP?

Step 1
Click on Start > Control Panel > Network and Internet Connections >
Network connections.

Step 2 See Step 2 for Windows 2000 and continue from there.

How can | assign a Static IP Address in Windows 20007

10 etk ome Dial-s Comnestioss:

Step 1 Right-click on My Network [y —————

Places and select Properties. T ———
g L 5 O %

Step 2 Right-click on the Local Network ana Diaup S 5

Area Connection which represents bt e e

your network card and select o

Properties. aemm—

Lecal Arue Cosnechons Frepertiss i -1

Cornesd uang.
|l D Lirk: DFE- 30T PD) Faat Ethamst Arkschar
o brackad st e by b i
Highlight Internet Protocol (TCP/ e
IP) and click Properties. | | fl
a "
ek, | e | Frpmin |
Dezaplan
1zian Cantsal P wircol Tha deledt
bsmmmwmm

L [ e=r]
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

How can | assign a Static IP Address in Windows 20007

(continued)

Click Use the following IP Address and o

enter an IP Address that is on the same Beresd

subnet as the LAN IP Address on your o gt Poekiog e adoeabody s rebo ety

router. Example: If the router’s LAN IP ML LRI

Address is 192.168.0.1, make your IP Db P kb bty

Address 192.168.0.X where X = 2-99. e ———

Make sure that the number you choose is —— [ .m.m . 0

not in use on the network. Detask gazne [132 1830 1

Set the Default Gateway to be the R et HE BT P

same as the LAN IP Address of your PR AR

router (192.168.0.1). )
I

Set the Primary DNS to be the same as —

the LAN IP address of your router
(192.168.0.1).

The Secondary DNS is not needed or enter a DNS server from your ISP.

Click OK twice. You may be asked if you want to reboot your computer. Click

Yes.
How can | assign a Static IP 4
Address in Windows 98/Me? e

Cimrd ko Wicsck Matwoda

C+-Link DFE FNIT PC1 Faet Efwimad Sdapied P ]

Step 1 From the desktop, right-click on the
Network Neigborhood icon (Win ME - My

Network Places) and select Properties.

O . = |
Farsmy Hubsexk Lagare
Highlight TCP/IP and click the Properties e ——— ]
button. If you have more than 1 adapter, EET BTG
then there will be a TCP/IP “Binding” for TEF P et o vt b o st

each adapter. Highlight TCP/IP > (your

network adapter) and then click :
Properties. [ o ] e |

70




Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

How can | assign a Static IP Address in Windows

98/Me? (continued)
Step 2 Click Specify an IP Address.

Enter in an IP Address that is on the same

subnet as the LAN IP Address on your router.

Example: If the router’s LAN IP Address is
192.168.0.1, make your IP Address
192.168.0.X where X is between 2-99. Make
sure that the number you choose is not in
use on the network.

Step 3 Click on the Gateway tab.

Enter the LAN IP Address of your router
here (192.168.0.1).

Click Add when finished.

Step 4 Click on the DNS Configuration tab.

Click Enable DNS. Type in a Host (can be
any word). Under DNS server search order,
enter the LAN IP Address of your router
(192.168.0.1). Click Add.

Step 5 Click OK twice.

When prompted to reboot your computer,
click Yes.

After you reboot, the computer will now have
a static, private IP Address.

Step 5 Access the web management. Open your web
browser and enter the IP Address of your D-Link device in
the address bar. This should open the login page for the web

1 ‘ukarced
s Conbgurakn | ks | Wi Conkoursion | Faddes

AniP ackbar: can be susras aly ssvprad s he conpue
11 po i hoes ret eniign P eekboss, ook
m’?r’nuid-iiﬁ;:'m-:-dmwih
thevspace ek

™ Dhin n Pk mes siwsionly
r et et

P fedrmzr: 192 068, 0 . 1d
S—

Bregs | Adeced | HelIs
DN Conkgrsion by | winds Covrsion | Paddess

Thafurd palevsmy i tha inzisbed Gabeas kol rall be the celedt
Thitsddes ored ivthe bl allbes s chdey i ahich thasss
st aw umd.

Huw gaturvag:
o4
Inishsd puisan

VE2 163,01 e

w |
AT I:I

Samch Orde

o

’7_|

oK Lol

management. Follow instructions to login and complete the configuration.
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Frequently Asked Questions (continued)

How do | open ports on my router?

To allow traffic from the internet to enter your local network, you will need to open up
ports or the router will block the request.

Step 1 Open your web browser

and enter the IP Address of Wirtual Server is used to allow Internet users access to LAN services.
your D-Link router @ Enabled © Disabled
(192.168.0.1). Enter username Nams [poanywnerel Cleer |
(admin) and your password Private IP 1921680100

(blank by default). Protocal Type  [UDP ]

Private Port

. 22
Step 2 Click on the Advanced PulicPot 2
on top and then click Virtual Schecle  © Awaye

Server on the left side. © From time [00.=] : [30 =] [AM =] 0 [00 =] - [0 =] [AM =]

Step 3 Check Enabled to soyfSn Zsofsun 2
activate entry.

Step 4 Enter a name for your virtual server entry.

Step 5 Next to Private IP, enter the IP Address of the computer on your local
network that you want to allow the incoming service to.

Step 6 Choose Protocol Type - either TCP, UDP, or both. If you are not sure, select
both.

Step 7 Enter the port information next to Private Port and Public Port. The private
and public ports are usually the same. The public port is the port seen from the WAN
side, and the private port is the port being used by the application on the computer
within your local network.

Step 8 Enter the Schedule information.
Step 9 Click Apply and then click Continue.

Note: Make sure DMZ host is disabled. If DMZ is enabled, it will disable all Virtual
Server entries.

Because our routers use NAT (Network Address Translation), you can only open a
specific port to one computer at a time. For example: If you have 2 web servers on
your network, you cannot open port 80 to both computers. You will need to configure
1 of the web servers to use port 81. Now you can open port 80 to the first computer
and then open port 81 to the other computer.
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Frequently Asked Questions (continued)

What is DMZ?

Demilitarized Zone:

In computer networks, a DMZ (demilitarized zone) is a computer host or small
network inserted as a neutral zone between a company’s private network and the
outside public network. It prevents outside users from getting direct access to a
server that has company data. (The term comes from the geographic buffer zone that
was set up between North Korea and South Korea following the UN police action in
the early 1950s.) ADMZ is an optional and more secure approach to a firewall and
effectively acts as a proxy server as well.

In a typical DMZ configuration for a small company, a separate computer (or host in
network terms) receives requests from users within the private network for access to
Web sites or other companies accessible on the public network. The DMZ host then
initiates sessions for these requests on the public network. However, the DMZ host is
not able to initiate a session back into the private network. It can only forward packets
that have already been requested.

Users of the public network outside the company can access only the DMZ host. The
DMZ may typically also have the company’s Web pages so these could be served to
the outside world. However, the DMZ provides access to no other company data. In
the event that an outside user penetrated the DMZ hosts security, the Web pages
might be corrupted but no other company information would be exposed. D-Link, a
leading maker of routers, is one company that sells products designed for setting up

aDMZ.

How do | configure the DMZ Host?

The DMZ feature allows you to forward all incoming ports to one computer on the local
network. The DMZ, or Demilitarized Zone, will allow the specified computer to be
exposed to the Internet. DMZ is useful when a certain application or game does not
work through the firewall. The computer that is configured for DMZ will be completely
vulnerable on the Internet, so it is suggested that you try opening ports from the
Virtual Server or Firewall settings before using DMZ.

Step 1 Find the IP address of the computer you want to use as the DMZ host.
To find out how to locate the IP Address of the computer in Windows XP/2000/ME/9x

or Macintosh operating systems please refer to Step 4 of the first question in this
section (Frequently Asked Questions).
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Frequently Asked Questions (continued)

How do | configure the DMZ Host? (continued)

Step 2 Log into the web based configuration
of the router by typing in the IP Address of the p=
router (default:192.168.0.1) in your web
browser. The username is admin (all
lowercase) and the password is password

(all lowercase)

DI-624
AR

Access Point

Uset narme:

'€ admin

Password: |

[Cremember my password

[ o

H Cancel ]

Step 3 Click the Advanced tab and then click on the DMZ button. Select Enable
and type in the IP Address you found in step 1.

Step 4 Click Apply
and then Continue to
save the changes.

Note: When DMZ is
enabled, Virtual Server
settings will still be
effective. Remember,
you cannot forward the
same port to multiple
IP Addresses, so the
Virtual Server settings
will take priority over

DMZ settings.

Dlink T T—
High-Speed 2.4GHz Wireless Routor

devanced BT Status Ip

DT iDemilkarized Zora] b wasd 10 alow @ single compiier an tie LAN 1o be axpoaed 1o

n-E2d |

*©

I
Virksa| Bansp

Fesformance

i DEE

Tha Wrlemmiet
= Enshled ¥ Disbled

1!JIEI:IE

P Addacs
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Frequently Asked Questions (continued)

How do | open a range of ports on my VDI-624 using Firewall rules?

Step 1 Access the router’s web configuration by entering the router’s IP Address in
your web browser. The default IP Address is 192.168.0.1. Login using your password.
The default username is “admin” and the password is blank.

If you are having difficulty accessing web management, please see the first question
in this section.

Step 2 From the web management Home page, click the Advanced tab then click
the Firewall button.

Step 3 Click on =AirPlus i
Enabled and type in W E‘HEME’G
High-Speed 2.4GHz Wireless Routor

a name for the new

DI-624
rule. ‘1 R ool Sioiue oy |
Step 4 Choose WAN = Flm.ul R;.lhl i b weaiad 10 alow of diny fraffie o pecsing ihiaugh the DHE2
as the Source and s * Emabird © Dicablrd

enter arange of IP thn Ll |
applboalions Aclian ™ tdow ™ Dany

Addresses OUt on the inbarace P Rarge Siwt  IF Rangs End Profecol Pad Range
internet that you [re— I O | |
would like this rule Loctimetin | | Irce =] :

. Schadule T flways
applled. to. If you * Fram tima [P0 2] - [0 2] [ =] 1o [0 ] . [ ] o =]
would like this rule to ay [Ban =] 10 [Ban =1
allow all internet oz @ 90

users to be able to Apply Cancel Help

Arfion  Hama Boaica Do Piotacal

0

access these ports, P low  Allaw b Fig WeN port WeANT LAN1E21EB01  ICMPRE
. ¥ Oeny Dafauh Lan” IPm.”
then put an Asterisk B i Tt Sis A

in the first box and
leave the second box

empty.

Step 5 Select LAN as the Destination and enter the IP Address of the computer on
your local network that you want to allow the incoming service to. This will not work

with a range of IP Addresses .

Step 6 Bter tte pxt ar rawe of pots thet are required to e qoen for the incomirg
service.

Step 7 Click Apply and then click Continue.

Note: Make sure DMZ host is disabled.

Because our routers use NAT (Network Address Translation), you can only open a
specific port to one computer at a time. For example: If you have 2 web servers on
your network, you cannot open port 80 to both computers. You will need to configure
1 of the web servers to use port 81. Now you can open port 80 to the first computer

and then open port 81 to the other computer. 75




Frequently Asked Questions (continued)

What are virtual servers?

A Virtual Server is defined as a service port, and all requests to this port will be
redirected to the computer specified by the server IP. For example, if you have an FTP
Server (port 21) at 192.168.0.5, a Web server (port 80) at 192.168.0.6, and a VPN
server at 192.168.0.7, then you need to specify the following virtual server mapping

table:

21
80

1723

192.168.0.5 X
192.168.0.6 X
192.168.0.7 X

How do | use PC Anywhere with my VDI-624 router?

You will need to open 3 ports in the Virtual Server section of your D-Link router.

Step 1 Open your web browser and enter the IP Address of the router (192.168.0.1).

Step 2 Click on Advanced at the top and then click Virtual Server on the left side.

Step 3 Enter the
information as seen
below. The Private IP
is the IP Address of the
computer on your local
network that you want to
connect to.

Step 4 The first entry
will read as shown here:

Step 5 Click Apply

and then click Continue.

Virtual Server
Yirtual Server is used to allow Internet users access to LAN services.

& Enabled © Disabled

Mame |pcanywhers M
Private IP W
Protocol Type ITP;,
Private Part |22—
Public Port 22
Schedule & Always
€ From time [00 x| - [00 7| [AM >] 1o [00 =] - [00 7| [AM =]
day [Sun =] to[Sun =]
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Frequently Asked Questions (continued)

How do | use PC Anywhere with my VDI-624 router? (continued)

Step 6 Create
a second entry Wittual Server is used to allow Interet users access to LAN semvices.

as shown here: & Enabled © Disablad

Marne Ipu:anywherez Clear |
Private IP |'|92.'IEB.D.1 0o

Protocol Type ITCP "I
Private Port |5531

. Public Port |5531
Step 7 Click
Apply and then Schedule & Always
click Continue. C From time |00 x| - [00 =] [AM =] ta [00 x| - 00 =] [AM ¥
daYISun 'Im ISun vl
Step 8 Create : _ _
athird and final irtual Server is used to allow Internet users access to LAN semvices.
entry as shown

& Enabled ¢ Disabled

Marng |pcanywher93 Clear |

Private IP 192.168.0.100

Pratacal Type IUDP vl
Private Port I5532

Public Port IEESE

Schedule & Always
¢ From time [00 7] [00 > [Am =] 1o [00 =] - [00 =] [ant ]
dayISun 'ltDISun "I

here:

Step 9 Click Apply and then click Continue.

Step 10 Run PCAnywhere from the remote site and use the WAN IP Address of the
router, not your computer’s IP Address. -



Frequently Asked Questions (continued)

How can | use eDonkey behind my D-Link Router?

You must open ports on your router to allow incoming traffic while using eDonkey.
eDonkey uses three ports (4 if using CLI):

4661 (TCP) To connect with a server

4662 (TCP) To connect with other clients

4665 (UDP) To communicate with servers other than the one you are connected to.
4663 (TCP) *Used with the command line (CLI) client when it is configured to allow
remote connections. This is the case when using a Graphical Interface (such as the

Java Interface) with the client.

Step 1 Open your web browser and enter the IP Address of your router
(192.168.0.1). Enter username (admin) and your password (leave blank).

Step 2 Click on Advanced and then click Firewall.

Step 3 Create a
new firewall rule:

Click Enabled. ~_Alrj Fl5 lus Ve
Enter a name High-Speed 2.4GHz Wireless Router
(edonkey).

Click Aliow. [ Home YU I Tools  Status  Help |
NeXt to Source' Firgwall Rulos can be usad 1o allow or deny frafic fram passing through 1he DEE24
SeIECt WAN PR & Enabled T Disabled

under interface. In nwe [y [

Action & Allrw ¢ Deny

the first box,
enter an *. Leave Interface IF Range Start P Range Erd  Protocol Pod Range
Sowce |NANj|‘

[
—
the second box A Destination [LAM =] [192.166.0.100 = =|[qeen . [w6ss

empty. Schedule  ® Alwaye
Next to € From time [00 =] ; [00 =] [Am =] 1o [00 =] : o0 =] [ =]
Destination, iy [Sun =] 10 [Som ]

@ 90
Apply Cancel Help

Action Name Sgurce Destination Pratocal

select LAN under
interface. Enter

o000

the IP Address of Performancs F Allow  Allow 1o Fing WAN port WANS® LAN19Z 18801 ICMPE |4
F Da Default Lan* 1P D"

the Com_pUter you [ ,mx Defau LAN ot 1P ,°

are running

eDonkey from.

Leave the second

box empty. Under Protocol, select *. In the port range boxes, enter 4661 in the first
box and then 4665 in the second box. Click Always or set a schedule.

Step 4 Click Apply and then Continue.
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Frequently Asked Questions (continued)

How do | set up my router for SOCOM on my Playstation 27?

To allow you to play SOCOM and hear audio, you must download the latest firmware
for the router (if needed), enable Game Mode, and open port 6869 to the IP Address of
your Playstation.

Step 1 Upgrade firmware (follow link above).

Step 2 Open your web browser and enter the IP Address of the router (192.168.0.1).
Enter username (admin) and your password (blank by default).

Step 3 Click on the Advanced tab and then click on Virtual Server on the left side.

Step 4 You will now create a new Virtual Server entry. Click Enabled and enter a
name (socom). Enter the IP Address of your Playstation for Private IP.

Step 5 For Protocol Type select Both. Enter 6869 for both the Private Port and
Public Port. Click Always. Click Apply to save changes and then Continue.

?ﬂfr,glua G-
High-Speed 2. 4GHz Wireless Routor

ikl S erved | ussd o ollow Inbarmen eers e e 1o LAN amiEs

® Embled ™ [izabled

Harra | socom Clewr
Applimiion Frivale IF m
Proipsol Typsa 'm
Fittars Prieate Port [6869
Publiz Pan 6869
Echadula ® Ahoye

™ Frarn e [00 2] - (00 2] [30 =] 1o (002 - [0 2] [ =]
day [Bun =] 1o [Bun =]

HEEE-

Forformance a a 0
Wil Li Apply Cancel Help
Harmm Friiaie P Proiocol Schetk
I “irual Sener FTR 00on TeP2E weays  CE
T Yl Sever HTTR 0000 TR B0 sways [
I Virual Sever HTTFS 0000 TOP a4 weays
T Yirual Sever ONS 0000 LOP 5363 LE TR | |

Step 6 Click on the Tools tab and then Misc on the left side.

Step 7 Make sure Gaming Mode is Enabled. If not, click Enabled. Click Apply
and then Continue. 79



Frequently Asked Questions (continued)

How can | use Gamespy behind my D-Link router?

Step 1 Open your web browser and enter the IP Address of the router (192.168.0.1).
Enter admin for the username and your password (blank by default).

Step 2 Click on the Advanced tab and then click Virtual Server on the left side.

Step 3 You will create 2 entries.

Step 4 Click Enabled and enter
Settings:

NAME - Gamespy1l

=AirBPlus
High-Speed 2.4GHz Wireless Router

m Advanced o5 Status Ip

g b ke nba et L0 BeeaEs 10 LAN bamcas.

PRIVATE IP - The IP
Address of your computer
that you are running e CEmn ]

el

e

Imm
s

Gamespy from. Piarot  [7E

[~
=l
—

® Embled © Dizabled

Haria [gamespyt — |Gew

Publiz Pan 3783

PROTOCOL TYPE - Both e Bctaki  ® Abae

" Fram time [00 2] - [0 =] [ 2] 1 [0 - [0 2] AW
s [l o [

PRIVATE PORT - 3783

PUBLIC PORT - 3783 ... 299
r m".:.s.....m oun; T-:Pnzstm d‘:: o8
SCHEDULE - Always. Slmssen, s mem S B
T irus | Sever OMS ooonon LOP 6383 whways _-i':_l
Click Apply and then continue.
—AirPlus
Step 5 Enter 2nd entry: oS A e L
Click Enabled e || g asvonced ETESET——TT
NAME - Gamespyz ‘ i uzadba alkrw ik Lo eecass fo LAN pamcas
1 bt =] ® Embled © Disabled
PRIVATE IP - The IP Bl b =
Address of your computer 2
that youare running i o %
Gamespy from. . e
- B v s [ s B s |
PROTOCOL TYPE - Both E aay[Bn =] 1o [Bn =]
PRIVATE PORT - 6500 == @00
N P
PUBLIC PORT - 6500 o
F Miral Sener HTTFS anan TP g3 m: jil
T Virual Sever OMS oo LOP 6363 sty £] |

SCHEDULE - Always.
Click Apply and then continue.




Frequently Asked Questions (continued)

How do | configure my router for KaZaA and Grokster?

The following is for KaZaA, Grokster, and others using the FastTrack P2P file sharing
system.

In most cases, you do not have to configure anything on the router or on the KazaA
software. If you are having problems, please follow steps below:

Step 1 Enter the IP Address of your router in a web browser (192.168.0.1).
Step 2 Enter your username (admin) and your password (blank by default).
Step 3 Click on Advanced and then click Virtual Server.

Step 4 Click Enabled and then enter a Name (KaZaA for example).

Step 5 Enter the IP Address of the computer you are running KaZaA from in the
Private IP box. Select TCP for the Protocol Type.

Step 6 Enter 1214 in the Private and Public Port boxes. Click Always under
schedule or set a time range. Click Apply.

m Advanced _ . Sttus _.__

i ! )
Imual 5 Iy

Winual Server is used to allow Internel users access to LAN seraces.

& Enabled © Digabled

Mame [kazas Clear I
Frivate IP 192.168.0.100

Prodocol Type |TCF TI

Priwate Port 1214
Public Port 1214
Sehadule = Ahways

© From tirme |00 =] - [00 =] |4 =] 1o [00 =] - [00 =] [Am =]
da:,-ISun 'It.:. Sun =

Make sure that you did not enable proxy/firewall in the KaZaA software.
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Frequently Asked Questions (continued)

How do | configure my router to play Warcraft 3?

You must open ports on your router to allow incoming traffic while hosting a game in
Warcraft 3. To play a game, you do not have to configure your router.

Warcraft 3 (Battlenet) uses port 6112.

For the VDI-624

Step 1 Open your web browser W A e
High-Speed 2.4GHz Wireless Router

and enter the IP Address of your wes | _ -
router (192.168.0.1). Enter L™ -’M_ setences WAV MR
username (admln) and yOur m ‘v'\nual!mmususauEm Hkmllnl;mluwi BeCake fo LAN s cas
| ® Embied © Dizabled
assword (leave blank). O - —
P ( ) PrtelP 1921680100 e
Fratocd Typa  [both =1
Step 2 Click on Advanced and _ T
then click Virtual Server. o A
 Fom 1me [002] : [0 2] [ 2] v [05.2] - [0 20 [ 2
Step 3 Create a new entry: Click 900
:
Enabled. Enter a name s I Sanven L ey Aogly Conce o
. Mamm i i (LT
(warcraft3). Private IP - Enter the e oy | e oM
IP Address of the computer you s . Daw e B

want to host the game. Select
Both for Protocol Type Enter 6112
for both Private Port and Public Port Click Always or set a schedule.

Step 4 Click Apply and then Continue.

Note: If you want multiple computers from you LAN to play in the same game that
you are hosting, then repeat the steps above and enter the IP Addresses of the other
computers. You will need to change ports. Computer #2 can use port 6113, computer
#3 can use 6114, and so on.

You will need to change the port information within the Warcraft 3 software for
computers #2 and up.

Configure the Game Port information on each computer:
Start Warcraft 3 on each computer, click Options > Gameplay. Scroll down and you

should see Game Port. Enter the port number as you entered in the above steps.
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Frequently Asked Questions (continued)

How do | use NetMeeting with my D-Link Router?

Unlike most TCP/IP applications, NetMeeting uses DYNAMIC PORTS instead of
STATIC PORTS. That means that each NetMeeting connection is somewhat different
than the last. For instance, the HTTP web site application uses port 80. NetMeeting
can use any of over 60,000 different ports.

All broadband routers using (only) standard NAT and all internet sharing programs like
Microsoft ICS that use (only) standard NAT will NOT work with NetMeeting or other
H.323 software packages.

The solution is to put the router in DMZ.

Note: Afew hardware manufacturers have taken it on themselves to actually provide
H.323 compatibility. This is not an easy task since the router must search each
incoming packet for signs that it might be a netmeeting packet. This is a whole lot
more work than a router normally does and may actually be a weak point in the
firewall. D-Link is not one of the manufacturers.

To read more on this visit http://www.HomenetHelp.com

How do | set up my router to use iChat? -for Macintosh users-

You must open ports on your router to allow incoming traffic while using iChat.
iChat uses the following ports: 5060 (UDP) 5190 (TCP) File Sharing 16384-16403
(UDP) To video conference with other clients.

Step 1 Open your web browser and enter the IP Address of your router

(192.168.0.1). Enter username (admin) and your password (leave blank).

Step 2 Click on Advanced and then click Firewall.
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Frequently Asked Questions (continued)

How do | set up my router to use iChat? -for Macintosh users-
(continued)

Step 3 Create a new

firewall rule: 1.3 —

Lol ArRlus .
Click Enabled. High-Speed 2.4GHz Wireless Router

DI-624
Enter a name 1 [ Home JVYVUTUNR Tools  Status  Help |
(ichatl). ‘ —
CI'Ck AI I ow. Fireweall Rules can be used 1o allow or deny trafic from passing through the DRE24
Next to Source, & Erabled © Dissbled

Name [..;m:l— Claar
_select WAN under e o Sewr|
interface. Wterfate I Range Sia 1° Range End  Proiocol Pon Range
In the first box, JR— Source [N Z]f |
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Leave the second & From vens [55 - [5T] F no [ - [ [T
box empty. day [Sm =] 1o [5om ]
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nter the

Address of the

computer you are running iChat from.

Leave the second box empty. Under Protocol, select UDP. In the port range boxes,
enter 5060 in the first box and leave the second box empty.
Click Always or set a schedule.

Bulding Metworks for Peopls

D-Link —AirrPlus %
Step 4 Click Apply High-Speed 2.4GHz Wireless Router

and then Continue. “"“*‘1 Advanced
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Frequently Asked Questions (continued)

How do | set up my router to use iChat? -for Macintosh users-
(continued)

For File Sharing:
Step 1 Click on
Advanced and then
Virtual Server.

Step 2 Check Enabled
to activate entry. JURSSVIN ool Status  Help |

Wirntual Server is used 1o allow Internet usess access to LAN sonices,

& Enabled  Disablod

Step 3 Enter a name for

i Harme foes s
ypur virtual server entry - S e |
(ichat3). et e [__|[T,p

Filters Prvate Pat  [E190
Step 4 Next to Private Public Pt [F190

IP, enter the IP Address Firewall Schedule & anays
of the computer on your € From time [003]  [00 5] [ = o 00 T [0 2] [ 2]

local network that you i e
want to allow the — _ 2 900

DI-E24 '|
v
Thesticatons.

i

i
Tomz
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incoming service to. Virtual Sorvars Ls Aoply Cancel Help
Mairs Prvate P Protocel Schedule
I Vietusl Seecor FTP o000 TERP 121 always £ |
Step 5 Select TCP for T Virtusl Sereer HITP 0000 TCP 800 abways [H5

Protocol Type.
Step 6 Enter 5190 next to Private Port and Public Port.
Stsp 7 Click Always or configure a schedule.

Step 8 Click Apply and then Continue.

If using Mac OS X Firewall, you may need to temporarily turn off the firewall in
the Sharing preference pane on both computers.

To use the Mac OS X Firewall, you must open the same ports as in the router:

Step 1 Choose Apple menu > System Preferences.

Step 2 Choose View > Sharing.

Step 3 Click the Firewall tab.

Step 4 Click New.

Step 5 Choose Other from the Port Name pop-up menu.

Step 6 In the Port Number, Range or Series field, type in: 5060, 16384-16403.
Step 7 In the Description field type in: iChat AV.

Step 8 Click OK.
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Frequently Asked Questions (continued)

How do | send or receive a file via iChat when the Mac OSX firewall
is active? -for Macintosh users- Mac OS X 10.2 and later

The following information is from the online Macintosh AppleCare knowledge base:

“iChat cannot send or receive a file when the Mac OS X firewall is active in its default
state. If you have opened the AIM port, you may be able to receive a file but not send
them.

In its default state, the Mac OS X firewall blocks file transfers using iChat or America
Online AIM software. If either the sender or receiver has turned on the Mac OS X firewall,
the transfer may be blocked.

The simplest workaround is to temporarily turn off the firewall in the Sharing preference
pane on both computers. This is required for the sender. However, the receiver may keep
the firewall on if the AIM port is open. To open the AIM port:

Step 1 Choose Apple menu > System Preferences.

Step 2 Choose View > Sharing.
Step 3 Click the Firewall tab.
Step 4 Click New.

Step 5 Choose AOL IM from the Port Name pop-up menu. The number 5190
should already be filled in for you.

Step 6 Click OK.

If you do not want to turn off the firewall at the sending computer, a different file sharing
service may be used instead of iChat. The types of file sharing available in Mac OS X are
outlined in technical document 106461, "Mac OS X: File Sharing" in the AppleCare Knowl-
edge base online.

Note: If you use a file sharing service when the firewall is turned on, be sure to click the

Firewall tab and select the service you have chosen in the "Allow" list. If you do not do
this, the firewall will also block the file sharing service. “
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Frequently Asked Questions (continued)

What is NAT?

NAT stands for Network Address Translator. Itis proposed and described in RFC-
1631 and is used for solving the IP Address depletion problem. Basically, each NAT
box has a table consisting of pairs of local IP Addresses and globally unique
addresses, by which the box can “translate” the local IP Addresses to global address
and vice versa. Simply put, it is a method of connecting multiple computers to the
Internet (or any other IP network) using one IP Address.

D-Link’s broadband routers (ie: DI-604) support NAT. With proper configuration,
multiple users can access the Internet using a single account via the NAT device.

For more information on RFC-1631: The IP Network Address Translator (NAT), visit
http://www.fags.org/rfcs/rfc1631.html
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Warranty
(USA only)

Subject to the terms and conditions set forth herein, GTE.Net LLC d/b/a Verizon Internet
Solutions and Verizon Internet Services Inc. (collectively “Verizon Online”) provide this Limited
Warranty for the products you are obtaining through Verizon Online (“Product(s)”). This
Limited Warranty is provided only to the person or entity (“Customer”) that originally purchased
the Product(s) from:

*Verizon Online and for

* Products purchased and delivered within the fifty states of the United States and the
District of Columbia Limited Warranty: Verizon Online warrants that the hardware portion of
the Product(s) will be free from material defects in workmanship and materials from the
date of original retail purchase of the Product(s) through Verizon Online for the period of one
year (“Warranty Period”), except as otherwise stated herein. Verizon Online’s sole obligation
shall be to repair or replace the defective hardware during the Warranty Period at no charge
to Customer or to refund the price at Verizon Online’s sole discretion. Such repair or
replacement will be provided by Verizon Online. The replacement hardware provided by
Verizon Online may not be new or have an identical make, model or part. Verizon Online may
in its sole discretion replace the defective hardware (or any part thereof) with any reconditioned
product that Verizon Online reasonably determines is substantially equivalent (or superior)
in all material respects to defective hardware. Repaired or replacement hardware will be
warranted for the remainder of the original Warranty Period from the date of the original
purchase from Verizon Online.

If a material defect is incapable of correction or if Verizon Online determines in its sole
discretion that it is not practical to repair or replace the defective hardware, the price paid by
Customer for the defective hardware will be refunded by Verizon Online upon return to
Verizon Online of the defective hardware. All hardware (or part thereof) that is replaced by
Verizon Online, or for which the purchase price is refunded, shall become the property of
Verizon Online upon replacement or refund. Limited Software Warranty: Verizon Online
passes on to Customer the warranty of the Licensor that the software portion of the Product
(“Software”) will substantially conform to the Licensor’s then current functional specifications
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for the Software, as set forth in the applicable documentation, from the date of Customer’s
purchase of the Software for a period of ninety (90) days (“Software Warranty”) DIRECTLY OR
INDIRECTLY, TO THE LIMITED WARRANTY. Except as otherwise required by law, including
New York laws relating to consumer transactions, any cause of action or claim Customer
may have with respect to the Product must be commenced within one (1) year after the claim
or cause of action arises or such claim or cause of action is barred. Some states do not allow
exclusion or limitation of incidental or consequential damages or limitations on how long an
implied warrant lasts, so the foregoing limitations and exclusions may not apply. This Lim-
ited Warranty provides specific legal rights and the product owner may also have other rights
which vary from state to state.

Copyright Statement: No part of this publication or document accompanying this Product
may be reproduced in any form, by any means or used to make any derivative such as
translation, transformation or adaptation without permission from Verizon Online, as
stipulated by the United States Copyright Act of 1976. Contents are subject to change
without prior notice. Copyright © 2004 by Verizon. All rights reserved. CE Mark Warning: This
is a Class B product. In a domestic environment, this Product may cause radio interference,
in which case the user may be required to take adequate measures. FCC Statement: This
Product has been tested and found to comply with the limits for a Class B digital device,
pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable
protection against harmful interference in a residential installation. This Product generates,
uses and can radiate radio frequency energy and, if not installed and used in accordance
with the instructions, may cause harmful interference to radio communication. However,
there is no guarantee that interference will not occur in a particular installation. If this
Product does cause harmful interference to radio or television reception, which can be
determined by turning the Product off and on, the Customer is encouraged to try to correct
the interference by one or more of the following measures:

» Reorient or relocate the receiving antenna.

* Increase the separation between the Product and receiver.

» Connect the Product into an outlet on a circuit different from that to which the receiver

is connected.

» Consult Verizon Online or an experienced radio/TV technician for help.

» Return Product shall be packaged and shipped to Verizon Teleproducts, 400 Brandywine
Parkway, West Chester, PA 19380. The Customer is responsible for taking the package to
a UPS Ground or a common carrier, selected by Verizon Online, with shipping charges
prepaid.
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What Is Not Covered: This Limited Warranty provided by Verizon Online does not cover Prod-
ucts, which in Verizon Online’s sole discretion, have been subjected to abuse, accident,
alternation, modification, tampering, negligence, misuse, faulty installation, lack of reason-
able care, repair of service in any way that is not contemplated in the documentation for the
Product or if the model or serial number has been altered, tampered with, defaced or re-
moved; Initial installation, installation and removal of the Product for repair and shipping
cost; Operational adjustments covered in the operating manual for the Product and normal
maintenance; Damage that occurs in shipment, due to an act of God, failures due to power
surge and cosmetic damage; Any hardware, software, firmware or other products or services
provided by anyone other than Verizon Online; Products that have been purchased from other
than Verizon Online; Repair by any party other than Verizon Online or as directed by Verizon
Online will void this Limited Warranty. Limitation of Liability: TO THE MAXIMUM EXTENT
PERMITTED BY LAW, VERIZON ONLINE IS NOT LIABLE UNDER ANY CONTRACT, NEGLI-
GENCE, STRICT LIABILITY OR OTHER LEGAL OR EQUITABLE THEORY FOR ANY LOSS OF
USE OF THE PRODUCT, INCONVENIENCE OR DAMAGES OF ANY CHARACTER, WHETHER
DIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL (INCLUDING, BUT NOT LIMITED
TO, DAMAGES FOR LOSS OF GOODWILL, LOSS OF REVENUE OR PROFIT, WORK STOP-
PAGE, COMPUTER FAILURE OR MALFUNCTION, FAILURE OF OTHER EQUIPMENT OR
COMPUTER PROGRAMS TO WHICH THE PRODUCT IS CONNECTED WITH, LOSS OF
INFORMATION OR DATA CONTAINED IN, STORED ON OR INTEGRATED WITHANY PROD-
UCT RETURNED TO VERIZON ONLINE FOR WARRANTY SERVICE) RESULTING FROM
THE USE OF THE PRODUCT RELATING TO WARRANTY SERVICE, OR ARISING OUT OF
ANY BREACH OF THIS LIMITED WARRANTY, EVEN IF VERIZON ONLINE HAS BEEN AD-
VISED OF THE POSSIBILITY OF SUCH DAMAGES. THE SOLE REMEDY FOR ABREACH OF
THE FOREGOING LIMITED WARRANTY IS REPAIR, REPLACEMENT OR REFUND OF THE
DEFECTIVE OR NON-CONFORMING PRODUCT. THE MAXIMUM LIABILITY OF VERIZON
ONLINE UNDER THIS WARRANTY IS LIMITED TO THE PURCHASE PRICE OF THE PROD-
UCT COVERED BY THE WARRANTY.

THE FOREGOING EXPRESS WRITTEN WARRANTIES AND REMEDIES ARE EXCLUSIVE
AND ARE IN LIEU OF ANY OTHER WARRANTIES OR REMEDIES, EXPRESS, IMPLIED OR
STATUTORY.

Governing Law: This Limited Warranty shall be governed by the laws of the State of New
York, without reference to its principles or conflicts of laws. CUSTOMER AND VERIZON
ONLINE CONSENT TO THE EXCLUSIVE PERSONAL JURISDICTION OF AND VENUE INA
COURT LOCATED IN NEW YORK COUNTY, NEW YORK, FORANY SUITS OR CAUSES OF
ACTION CONNECTED INANY WAY, Period”), provided that the Software is properly installed
on approved hardware and operated as contemplated in its documentation. Verizon Online
further passes on to Customer the warranty of the Licensor that, during the Software Warranty
Period, the magnetic media on which the Licensor delivers the Software will be free of
physical defects
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The Licensor’s sole obligation shall be to replace the non-conforming Software (or defective
media) with software that substantially conforms to the Licensor’s functional specifications
for the Software or to refund the purchase price for the Software at Verizon Online’s sole
discretion. The replacement Software is provided only to the original Customer and is sub-
ject to the terms and conditions of the license granted by the Licensor for the Software.
Software will be warranted for the Software Warranty Period set forth above from the date the
replacement Software is returned to Customer. If a material non-conformance is incapable
of correction, or if Verizon Online determines in its sole discretion that it is not practical to
replace the non-conforming Software, the price paid by the Customer for the non-conforming
Software will be refunded by Verizon Online; provided that the non-conforming Software (and
all copies thereof) is returned to Verizon Online. The license granted respecting any Software
for which a refund is given automatically terminates. Non-Applicability of Warranty: The
Limited Warranty provided hereunder for hardware and software Product will not be applied
to and does not cover any Product not purchased directly through and from Verizon Online.
Submitting a Claim: Customer may return the Product to Verizon Online based on its return
policy. In case the return policy period has expired and Product is within the Warranty Period,
Customer shall submit a claim to Verizon Online as outlined below, provided that only Cus-
tomer may submit a claim:

e Customer must submit with the Product as part of the claim a written description of the
hardware defect or Software non-conformance in sufficient detail to allow Verizon Online to
confirm the same.

e Customer must obtain a Return Authorization (“RA”) number from Verizon Online and, if
requested, provide written proof of purchase of Product (such as a copy of the dated purchase
invoice of the Product) before the warranty service is provided.

» Upon Customer’s request, Verizon Online will provide Customer with an RA and postage-
paid package for the original Product under warranty. No Cash on Delivery (“COD”") returns
are allowed.

 After an RA number is issued, the defective Product must be packaged securely in the
provided packing material, original or other suitable shipping package, to ensure that it will
not be damaged in transit, and the RA number must be prominently marked on the outside
of the package. All accessories and manuals must be included in the shipping package,
such as the power cord and Ethernet cable.
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